# Table of Contents

## Chapter 1  Getting Started

Overview ................................................................. 7  
ShoreTel Communicator Features ..................................... 7  
Installing ShoreTel Communicator .................................... 8  
Starting ShoreTel Communicator ...................................... 8  
  - Automatically starting ShoreTel Communicator .................. 8  
  - Manually starting ShoreTel Communicator ....................... 8  
The ShoreTel Communicator Window .................................. 10  
  - ShoreTel Button .................................................. 11  
  - The Assignment Bar ............................................. 12  
  - Toolbars .......................................................... 12  
  - QuickDialer ...................................................... 13  
  - Active Call Area ................................................ 14  
  - Content Area and Content Windows ............................. 14  
  - Status Bar ....................................................... 17  
  - ShoreTel Notification Icon ..................................... 17  
  - Organizing Your Desktop ....................................... 18  
Upgrading ShoreTel Communicator .................................... 19  
Exiting ShoreTel Communicator ....................................... 20

## Chapter 2  Making and Managing Calls

Overview ................................................................. 22  
Specifying Your Communication Device .............................. 23  
Using ShoreTel SoftPhone ........................................... 23  
Enabling Handsfree Mode ............................................ 23  
Selecting Your Off-Hook Device .................................... 24  
Defining Call Routing ................................................ 24  
Making Calls .......................................................... 27  
Answering a Call ..................................................... 28  
Transferring Calls .................................................... 29  
Routing a Call ........................................................ 29  
Calls on Hold .......................................................... 30  
Recording a Call ...................................................... 31  
Muting a Call .......................................................... 31  
Sending Digits While on a Call ..................................... 32  
Conference Calls ...................................................... 32  
Using ShoreTel Web Conferencing ................................... 33  
Ending a Call .......................................................... 33
Table of Contents

Chapter 3 Working with Voice Mail .................................................. 34
  Overview ................................................................. 35
  Using the Voice Mail Window ................................................. 35
  Listening to Voice Mail ....................................................... 37
  Replying to Voice Mail ...................................................... 37
  Managing Voice Mail ......................................................... 38
  Creating New Voice Mail ..................................................... 40
  Managing Distribution Lists .................................................. 41

Chapter 4 Instant Messaging, Email, and Video ................................. 44
  Overview ................................................................. 45
  Using Instant Messaging ..................................................... 45
    The Chat Window ......................................................... 46
    Initiating an IM Session ................................................ 46
  Using Email ............................................................. 49
  Using Video ............................................................... 50
    Using the Video Window ................................................ 50
    Adding Video to a Call ................................................ 51
    Accepting a Call with Video .......................................... 51
    Joining a Video Conference with LifeSize ........................... 51
    Putting a Video on Hold ............................................... 52
    Transferring a Voice Call with Video ................................. 52
    Ending a Video Session ............................................... 52
  Overview ................................................................. 54
  Identifying Presence ....................................................... 54
  Presence Icons .......................................................... 54
  Organizing Contacts ........................................................ 57
    Uploading Your Contacts ................................................ 57
    Adding, Editing, and Deleting Contacts .............................. 58
    Grouping Contacts ..................................................... 59
    Searching for a Contact ............................................... 59
    Changing Contact Views ............................................... 60
    Changing the Order of Contacts ...................................... 60
    Working with Columns .................................................. 60
    Exporting Contacts ..................................................... 61

Chapter 6 Microsoft Outlook with ShoreTel Communicator ...................... 62
  Overview ................................................................. 63
  Enabling Outlook Integration .............................................. 63
  Working with Outlook Contacts in ShoreTel Communicator .............. 64
  Using Outlook with Voice Mail ............................................ 64
  Viewing Presence Status in Outlook ..................................... 68
  Making a Call and Initiating IM ......................................... 68
  Creating and Joining a ShoreTel Web Conference ........................ 69
  Automatically Setting Call Handling Using Outlook ..................... 69
### Chapter 7  Special Features

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>72</td>
</tr>
<tr>
<td>Making Calls</td>
<td>72</td>
</tr>
<tr>
<td>Using the Make Call Dialog Box</td>
<td>72</td>
</tr>
<tr>
<td>Making and Answering Special Calls</td>
<td>72</td>
</tr>
<tr>
<td>Intervening in a Call</td>
<td>73</td>
</tr>
<tr>
<td>Transferring Calls to Special Recipients</td>
<td>74</td>
</tr>
<tr>
<td>Parking and Picking Up a Call</td>
<td>74</td>
</tr>
<tr>
<td>Changing Another User’s Call Handling Mode</td>
<td>75</td>
</tr>
<tr>
<td>Sharing Call Appearance</td>
<td>76</td>
</tr>
<tr>
<td>Viewing and Adding Information on a Call</td>
<td>76</td>
</tr>
<tr>
<td>Using ShoreTel Workgroups</td>
<td>77</td>
</tr>
<tr>
<td>Logging into and out of a Workgroup</td>
<td>78</td>
</tr>
<tr>
<td>Using Call Wrap-Up</td>
<td>79</td>
</tr>
<tr>
<td>Monitoring Your Queue</td>
<td>79</td>
</tr>
<tr>
<td>Monitoring Agents</td>
<td>80</td>
</tr>
<tr>
<td>Monitoring Bridged Calls</td>
<td>81</td>
</tr>
<tr>
<td>Using a Workgroup Voice Mailbox</td>
<td>82</td>
</tr>
<tr>
<td>Transferring Calls from the Contacts Window</td>
<td>82</td>
</tr>
</tbody>
</table>

### Chapter 8  Customizations

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>84</td>
</tr>
<tr>
<td>Customizations</td>
<td>84</td>
</tr>
<tr>
<td>Configuring Call Handling Modes</td>
<td>86</td>
</tr>
<tr>
<td>Personalizing Call Handling</td>
<td>87</td>
</tr>
<tr>
<td>Specifying Voice Mail Options</td>
<td>90</td>
</tr>
<tr>
<td>Enabling Microsoft Outlook Integration Features</td>
<td>92</td>
</tr>
<tr>
<td>Specifying Workgroups Options</td>
<td>92</td>
</tr>
<tr>
<td>Specifying Telephony Options</td>
<td>93</td>
</tr>
<tr>
<td>Specifying Instant Messaging Options</td>
<td>94</td>
</tr>
<tr>
<td>Specifying SoftPhone Options</td>
<td>96</td>
</tr>
<tr>
<td>Specifying Video Options</td>
<td>96</td>
</tr>
<tr>
<td>Choosing Sounds</td>
<td>97</td>
</tr>
<tr>
<td>Identifying the Language to be Used</td>
<td>98</td>
</tr>
<tr>
<td>Personalizing ShoreTel Communicator</td>
<td>98</td>
</tr>
</tbody>
</table>
CHAPTER 1

Getting Started

Overview ................................................................. 7
ShoreTel Communicator Features ........................................ 7
Installing ShoreTel Communicator ....................................... 8
Starting ShoreTel Communicator ......................................... 8
  Automatically starting ShoreTel Communicator ................. 8
  Manually starting ShoreTel Communicator ....................... 8
The ShoreTel Communicator Window .................................. 10
  ShoreTel Button .......................................................... 11
  The Assignment Bar ..................................................... 12
  Toolbars ........................................................................ 12
  QuickDialer .................................................................... 13
  Active Call Area ............................................................ 14
  Content Area and Content Windows ................................. 14
  Status Bar ....................................................................... 17
  ShoreTel Notification Icon ........................................... 17
  Organizing Your Desktop .............................................. 18
Upgrading ShoreTel Communicator .................................... 19
Exiting ShoreTel Communicator ......................................... 20
Overview

ShoreTel Communicator presents a single interface to manage business communications using your ShoreTel desk phone, computer, mobile phone, or home telephone. This means that you can move seamlessly between voice, video, or instant messages (IM).

Using ShoreTel Communicator simplifies your day-to-day communications, streamlines your work, and makes it easier to stay in the loop by putting intuitive communication and collaboration tools at your fingertips. ShoreTel Communicator for Windows also integrates with Microsoft Outlook.

ShoreTel Communicator Features

With ShoreTel Communicator you can:

- Quickly Access Your Directories
  ShoreTel Communicator provides immediate access to your online directories and personal Microsoft Outlook contacts. This feature makes it easy to quickly connect to the right person and to contact coworkers using IM or email.

- Manage your Contacts from within Microsoft Outlook
  With Microsoft Outlook integration, you can manage your voice mail and contacts using a full set of flexible, productivity-enhancing features. This includes the ability, from within Outlook, to call contacts and define how your calls are handled when in a meeting or appointment.

- Identify a Contact’s Phone and IM Presence
  Uniquely, ShoreTel Communicator indicates both phone and IM presence. So you can immediately see a contact’s phone and IM presence status, allowing you to determine the best way to reach them. Presence status is also displayed in Microsoft Outlook.

- Never Miss a Call
  You can choose to be reached through multiple phones, or through a progression of escalated phones. And if you are unable to answer a phone, you can specify that your calls go directly into voice mail.

- Personalize Call Handling
  Using ShoreTel Communicator, you can personalize how your incoming calls are handled based on caller identity, when a call was placed, and your active call handling mode. Calls can be automatically sent to voice mail or to another phone number. You can also play specific ringtones based on caller identity.

- Turn Your PC into a Telephone
  With ShoreTel Communicator’s SoftPhone, any Microsoft Windows computer can be turned into a telephone to be used in your home office or on the road. The ShoreTel Communicator fully integrated interface makes it easy to turn your PC into a telephone.
Installing ShoreTel Communicator

ShoreTel Communicator may already be installed on your system. If ShoreTel Communicator is not installed, contact your system administrator for the URL of the ShoreTel Communicator Installation page.

1. Make sure you have internet connectivity before beginning the installation process then point your browser to the URL of the ShoreTel Communicator Installation page.

2. Complete the Install Wizard.

Starting ShoreTel Communicator

You can choose to manually start ShoreTel Communicator or to have ShoreTel Communicator automatically start each time you log onto your system.

As part of configuring you as a user of ShoreTel Communicator, your system administrator initially set your ShoreTel Communicator and voice mail passwords. The first time you start ShoreTel Communicator, you are prompted to change these passwords to a password that you want to use. You are also asked to record your name for use by system and voice mail.

Automatically starting ShoreTel Communicator

1. From the ShoreTel button, click Options.

2. Click Customization.

3. Select the option Start ShoreTel Communicator when you log on to Windows, and click OK.

   The next time you start your computer, ShoreTel Communicator automatically opens, indicating your phone number or extension in the Title bar.

Manually starting ShoreTel Communicator:

1. From the Windows desktop, click Start > Programs > ShoreTel > ShoreTel Communicator.

   You can also click the ShoreTel Communicator icon on your desktop, or in the Windows Start menu, to start ShoreTel Communicator.

   2. If a more recent version of ShoreTel Communicator is available, you are presented with the opportunity to upgrade.

      Refer to the section Upgrading ShoreTel Communicator on page 19 for details.
3. If this is your first time starting ShoreTel Communicator, the Welcome panel is displayed. Click Next.

4. Set up your ShoreTel account, specify the following:
   - Server Name – The IP address or fully qualified domain name (FQDN) of the ShoreTel server.
   - User Name – Your ShoreTel system user name or domain user name.
   - User Password – Your ShoreTel system password or domain password.

5. Click Next.

Note
By default the Use Windows credentials option is selected, causing the fields to be automatically filled in with the appropriate information for your ShoreTel account. If you want enter your own information, unselect the Use Windows credentials option.

After starting ShoreTel Communicator, you can change this information. See the section Specifying Telephony Options on page 93 for information.

6. If the account has been successfully configured, click Next.

7. Use the resulting panel to change your ShoreTel Communicator password by typing the password in the New Password and Confirm Password fields. Then click Next.

8. In the Change Your Telephone Password panel, specify a new password to access your voice mail in the New Password and Confirm Password field, and click Next.

After starting ShoreTel Communicator, you can change your voice mail password. Refer to the section Specifying Voice Mail Options on page 90 for information.

9. Click Next.

10. Record your name by clicking the Record button, and speaking into your telephone handset or headset. When done, click Stop. Use the Play button and cursor to review the recording. When satisfied with the recording hang up. Then click Next.
After starting ShoreTel Communicator, you are able to change how your name is recorded, as explained in the section Specifying Voice Mail Options on page 90.

11. In the Congratulations panel click Finish. If you want ShoreTel Communicator to automatically start when you log into Windows, select the Start ShoreTel Communicator when you logon to Windows option first.

ShoreTel Communicator opens, indicating your phone number or extension in the Title bar.

The ShoreTel Communicator Window

The ShoreTel Communicator window is made up of the:

- ShoreTel button
- Assignment bar
- Toolbars
- QuickDialer
- Active Call area
- Content area and Content windows
- Status bar

The components of your ShoreTel Communicator window may be different depending on how your system administrator has configured the application, your platform, and the current viewing mode. Viewing modes are explained in the section Choosing a Viewing Mode on page 19.
You can customize the ShoreTel Communicator user interface by specifying the:

- Language used.
- Background color of ShoreTel Communicator windows and panels.
- Amount of time ShoreTel Communicator is idle before being hidden.
- Keyboard focus when ShoreTel Communicator becomes active.

Refer to the sections Identifying the Language to be Used on page 98 and Personalizing ShoreTel Communicator on page 98 for details.

**ShoreTel Button**

The ShoreTel button appears as the ShoreTel logo in the upper left corner of the ShoreTel Communicator window. Clicking on the ShoreTel button displays commands for the most common features and to access online Help.
The Assignment Bar

The Assignment bar allows you to assign your primary phone, call handling mode, IM presence and connection status, and choose the ShoreTel Communicator windows you want to see.

The Assignment bar also displays icons, on the right side of the bar, that indicate the state of your current calls and voice mail, and if there is any trouble (errors) with your phone. These icons are:

- Indicates the current call and on-hook phone status, and displays the quantity of unanswered calls.
- Shows the number of new voice mails.
- The mute status of the current call.
- Opens a keypad through which dialing tones (DTMF) can be sent during active voice calls.

Toolbars

Toolbars provide single-click access to ShoreTel Communicator tasks.
QuickDialer

The QuickDialer offers rapid access to directories and Outlook contacts, from which you can make a phone call, start an IM session, or send an email.

The QuickDialer can be customized by:

- Including fax numbers for contacts.
- Searching by company name.
- Displaying available methods of contacting filtered extensions.
- Showing a Go arrow on the right of the QuickDialer field. Clicking the Go arrow initiates a call to the contact in the field.
- Specifying the type of recently made and received calls displayed from the Redial icon.

See the section Personalizing ShoreTel Communicator on page 98 for details.

Accessing a contact using the QuickDialer

1. From the QuickDialer field drop-down menu, choose from the list of recent contacts.

2. To find a contact that you have not recently been in touch with, enter information on the contact in the QuickDialer field; matches from the directory are displayed as the text is entered.

   The following information can be entered in the QuickDialer field to find a contact:
   
   - The recipient's name, as listed in your directory.
   - The recipient's number, as listed in your directory.
   - A valid phone number, as specified by your system.
   - Company name (if the Search by company name option is selected; see the section Personalizing ShoreTel Communicator on page 98).
   - Address.
   - IM address.
   - Department name, as a name qualifier.

3. From the list, select method you want to use to contact the recipient.
Active Call Area

The Active Call area displays a list of your active calls, in the order they are made and received. If you have more than one active call, new calls are added to the bottom of the list.

Information on a call include the caller’s name and phone number, and the current status of the call. Icons provide a visual indication of call status. The call status icons, shown to the left of the caller details, are:

- 🔄 - Incoming Call
- 📞 - Connected
- 🎸 - Hold
- 🗑️ - Secure

Icons to the right of caller details allow you to manage calls from the Active Call area, as explained in Chapter 2.

You can customize the Active Call area by:

- Specifying the number of calls that can be handled by ShoreTel Communicator and listed in the Active Call area. Calls that you receive while the Active Call area is full are handled as busy.
- Displaying empty call cells.

See the section Specifying Telephony Options on page 93 for details.

Content Area and Content Windows

The Content area displays ShoreTel Communicator content windows. By default, only the Contents, Voice Mail, and History windows are available. To open the other windows, from the Windows menu choose the window you want to open.

The ShoreTel Communicator content windows are:

- Call Details
- Contacts
- History
- Voice Mail
- Directory
- Speed Dial
- Conference Web Portal
You can easily move between ShoreTel Communicator content windows by clicking the appropriate tab at the bottom of the Content area. Content windows can also be displayed in a separate standalone window. See the section Displaying Separate Content Windows on page 18 for details.

**Call Details Window**

The Call Details window shows information on an active call, including the destination or origination of the call and the call routing. You can also use the Call Details window to add information on the active call by creating a call note.

**Contacts Window**

You use the Contacts window to list the contact you call most frequently. You can add entries from the system directory, Microsoft Outlook, and your personal contacts. Then you can group the entries to make it easier to find the contact you want. The Contacts window also indicates the presence of a contact.

The appearance of the Contents window toolbar can be changed by clicking Customize and using the Customize Toolbar dialog box to:

- Change the button style
- Show or hide a button
- Move a button to a different location on the toolbar

To return the toolbar to its default appearance, right-click on the toolbar and from the resulting menu choose Reset Toolbar.

From the Contacts window, you can also:

- Make and manage phone calls
- Create a voice mail
- Initiate an IM session
- Send an email

**History Window**

The History window displays all previous incoming and outgoing calls. You can also make and manage calls from the History window.

Information on a call is displayed in columns and includes whether the call was incoming or outgoing, the name and phone number of the person who made or received the call, the date and time of the call, and call duration. Additional columns provide information on:

- Call Note. Shows information associated with the call.
- Account Code. Displays the account code associated with a call.
- GUID. A number that identifies a call record.
- Trunk. The system trunk through which the call was conducted.

Up to 1,000 calls can be listed in the History window; calls are added to the window when completed and are listed in the order received or made. When the window contents exceeds capacity, the oldest records are removed when you next exit ShoreTel Communicator.

Icons provide a visual indication of the call's history. The history icons are:

- Missed
- From
- To
- Message
- Transferred

**Voice Mail Window**

A list of your voice mails, in the order they are received, is shown on the Voice Mail window. Using the Voice Mail window you can select your playback and recording device; listen to, reply to; and create a voice mail, and manage your voice mail. See Chapter 3. for information.

The Voice Mail window also contains the Playback bar to control the audio playback of voice messages.

The appearance of the Voice Mail window toolbar can be changed by clicking Customize and using the Customize Toolbar dialog box to:

- Change the button style
- Show or hide a button
- Move a button to a different location on the toolbar

To return the toolbar to its default appearance, right-click on the toolbar and from the resulting menu choose Reset Toolbar.

**Directory Window**

The Directory window displays contact information for all system users. You can upload your Microsoft Outlook contacts, and add personal contacts, to the Directory window. The Data Source column indicates the source of a contact.

To quickly scroll through the contacts in the Directory window, press the keyboard End key. The focus of the window moves to the last item on the current page.
If you want to include fax numbers in the Directory window right-click menu, select the **Show fax numbers** option, as explained in the section **Personalizing ShoreTel Communicator** on page 98.

From the Directory window, you can also:

- Make phone calls
- Initiate an IM session
- Create voice mail
- Send an email

### Speed Dial Window

The Speed Dial window provides a list of contacts that you can **call by speed dialing**. The first ten contacts in the Speed Dial window are associated with a numeric key.

In addition to initiating voice calls, you can **add, remove, and edit speed dial contacts** from this window.

### Conference Web Portal

The Conference Web Portal window opens in your browser, allowing you to make a conference call. Refer to the **ShoreTel Conferencing User Guide** for information.

### Status Bar

The Status bar, located at the bottom of the ShoreTel Communicator window, displays error and status messages.

### ShoreTel Notification Icon

The notification area of the Windows taskbar displays the ShoreTel icon when ShoreTel Communicator is running.

Resting your cursor on the icon displays your phone number or extension. Clicking the icon opens the ShoreTel Communicator window on your desktop.

By right-clicking on the ShoreTel notification icon, and choosing the appropriate command from the resulting menu, you can do the following without having to open the ShoreTel Communicator window:

- Access the ShoreTel Communicator Dial menu, Windows menu, and View menu.
- Assign extensions
- Set your IM presence
- Identify how your incoming calls are handled
- Customize ShoreTel Communicator
- Get Help
- Exit ShoreTel Communicator

You can also open the ShoreTel Communicator window on your desktop from the ShoreTel notification icon.

The ShoreTel notification icon turns gray when ShoreTel Communicator is disconnected from the server.

Organizing Your Desktop

You can organize your desktop to reflect how you use ShoreTel Communicator. Your desktop can be organized by:

- Displaying ShoreTel Communicator content windows in a separate standalone window.
- Choosing a viewing mode.
- Showing specific ShoreTel Communicator window components.
- Specifying that ShoreTel Communicator is always the top application.

Displaying Separate Content Windows

ShoreTel Communicator content windows can be displayed in a separate standalone window, by right-clicking on the window header or tab, and dragging the window to a place on your desktop. A separate window can contain more than one content window (the additional windows are displayed as tabs). Alternatively, a separate window can be opened for each content window.

Separate windows can be combined, and a separate window can be dragged back to the Content area if desired. Combining separate windows displays drop targets in the receiving window – one for each side of the window, and one for the center. As you move the separate window into a receiving window, select the drop target icon representing the area where you want to place the dragged window and then release. A preview shadow indicates where the window will be placed.

Moving a separate window back into the Content area of the ShoreTel Communicator window displays two sets of drop targets. The outer targets are used for adding the Content area to hold the window. The interior drop targets are used to incorporate the separate window into the existing Content area.

You must have the **Enable Drag-and-Drop Window Arrangement** option selected to display these windows on your desktop, as explained in the section **Personalizing ShoreTel Communicator on page 98**.
Choosing a Viewing Mode

ShoreTel Communicator provides three viewing modes: Normal, Miniature, and Docked. The Normal view contains all ShoreTel Communicator window components. The Miniature view is a compact version of the ShoreTel Communicator window, and displays only the ShoreTel Communicator button, the QuickDialer, and the toolbars you want to see; in this mode ShoreTel Communicator content windows automatically appear as separate standalone windows.

Four docked views allow you to dock the ShoreTel Communicator window a side of your monitor screen. When ShoreTel Communicator is docked to the top or bottom of the monitor, ShoreTel Communicator content windows automatically appear in separate standalone windows.

To select a viewing mode, select the ShoreTel Button > View menu, and choose the view mode you want. When ShoreTel Communicator is next opened, it maintains the viewing mode last selected.

Showing ShoreTel Communicator Window Components

You can choose which ShoreTel Communicator components you want to show. These components are the Menu bar, the toolbars, and the Status bar.

To show a windows component, select the ShoreTel Button>View menu and choose the window components you want to show.

Specifying ShoreTel Communicator as Top Application

You can specify that ShoreTel Communicator appears always on top of other running applications.

To specify ShoreTel Communicator as the top application, select ShoreTel Button>View menu and choose Always on Top.

Upgrading ShoreTel Communicator

Whenever a new version of ShoreTel Communicator is available, you are given the opportunity to upgrade.

An upgrade may be either required or optional, as determined by your system administration. If you choose not to upgrade by clicking No in the Upgrade Required prompt, and the upgrade is required, ShoreTel Communicator closes.

If the upgrade is optional and you click No in the Upgrade Required prompt, your current version of ShoreTel Communicator opens. You can then upgrade at a later time by choosing Help > Upgrade from ShoreTel Communicator.
Exiting ShoreTel Communicator

ShoreTel Communicator must be running to monitor the system for messages, view presence, or engage in chat. Closing ShoreTel Communicator simply closes the Communicator window; ShoreTel Communicator continues to run in the background. The ShoreTel icon is displayed in the notification area of the Windows taskbar when ShoreTel Communicator is running.

You terminates the running of ShoreTel Communicator by right-clicking on the ShoreTel notification icon and choosing Exit.
CHAPTER

2

Making and Managing Calls

Overview ................................................................................................................... 22
Specifying Your Communication Device ................................................................. 23
Using ShoreTel SoftPhone ..................................................................................... 23
Selecting Your Off-Hook Device ............................................................................ 24
Defining Call Routing ............................................................................................. 24
Making Calls .......................................................................................................... 27
Answering a Call .................................................................................................. 28
Transferring Calls ................................................................................................. 29
Routing a Call ....................................................................................................... 29
Calls on Hold ....................................................................................................... 30
Recording a Call .................................................................................................. 31
Muting a Call ....................................................................................................... 31
Sending Digits While on a Call ............................................................................. 32
Conference Calls ................................................................................................. 32
Using ShoreTel Web Conferencing ...................................................................... 33
Ending a Call ....................................................................................................... 33
Overview

With ShoreTel Communicator you have integrated telephone-to-telephone call capabilities. This means that you can use either a telephone or your computer to:

- Specify your communication device
- Define call routing
- Make calls
- Answer calls
- Transfer calls
- Route a call
- Place a call on hold
- Record a call
- Mute a call
- Send digits while on a call
- Create a conference call
- End calls

Making and managing special types of calls, usually done by operators and assistants, is explained in Chapter 7. Information on ShoreTel Communicator’s Presence feature, which you can use to inform colleagues of your, and be informed of their, availability to receive a call can be found in Identifying Presence on page 54.

You can customize how ShoreTel Communicator interacts with your communication device by:

- Suppressing the call waiting tone, which is a signal inserted into the audio path during a voice call to alert you of an inbound call. Calls that you receive when the call waiting tone is suppressed are handled as specified by your active call handling mode.
- Specifying the prefix that must be dialed to make an external call, so that you do not have dial the number.
- Choosing the sounds to be played for incoming internal and external calls.
- Identifying the language used to display your IP phone messages.

For information, see the section Specifying Telephony Options on page 93.
Specifying Your Communication Device

With ShoreTel Communicator you have the ability to specify the device you want to use to make and receive calls. This includes using your computer with ShoreTel SoftPhone, using a headset or speaker phone by enabling handsfree mode, or using an off-hook device like a wireless headset or Bluetooth device.

Using ShoreTel SoftPhone

SoftPhone is a ShoreTel Communicator component that allows you to make calls and use voice mail directly through your computer’s audio features.

You can choose the sounds that SoftPhone plays for incoming internal and external calls; for information see section Choosing Sounds on page 97. You can also specify SoftPhone device settings, as explained in the section Specifying SoftPhone Options on page 96.

SoftPhone is a licensed feature and may need to be enabled by your system administrator.

Using SoftPhone

1. Plug your headset into your computer’s audio outlet.

2. Assign your extension to SoftPhone.

   Your extension remains assigned to SoftPhone until you either assign your extension to another device or shut down your computer.

3. Use ShoreTel Communicator to make and manage calls, as explained in this chapter.

Enabling Handsfree Mode

Enabling handsfree mode makes it possible to use ShoreTel Communicator with a headset or speaker phone. The phone is off hook and the dial tone is suppressed. At the conclusion of a call you can initiate a new call without hanging up the phone.

Enabling handsfree mode

1. From the ShoreTel button choose Options.

2. Click Telephony from the Options and Preferences window.

   The Telephony page is displayed.

3. Select Suppress dial-tone when off-hook to use ShoreTel Communicator with a headset or speaker phone instead of a receiver (i.e. in handsfree mode).

   The phone is off hook and the dial tone is suppressed. At the conclusion of a call you can initiate a new call without hanging up the phone.

4. Click OK.
Selecting Your Off-Hook Device

If you choose to use ShoreTel Communicator with an off-hook device like a wireless headset or Bluetooth device, choose the default device from the ShoreTel button > Default Auto Off-Hook.

Defining Call Routing

With ShoreTel Communicator, you can define how calls to your specified device are routed by:

- Assigning an extension
- Identifying how inbound calls are handled
- Enabling additional devices to ring simultaneously
- Allowing callers to find you
- Personalizing call handling

Assigning an Extension

By default, your system administrator has assigned you an extension, which is designated as your primary phone. To make and receive calls from a different phone, you must assign your extension to that phone. Your extension can be assigned to ShoreTel SoftPhone or any other phone that you configure for this purpose. The ability to assign your extension to another phone requires authorization from your system administrator.

For example, if you are remotely connected to your office via a Virtual Private Network (VPN), you can still manage your calls with ShoreTel Communicator for Mac while receiving your extension calls on an external phone (such as your mobile or home office phone).

Once you have assigned your extension to a phone, you can define how incoming calls to that phone are routed.

1. Click on the extension assignment icon on the Assignment bar.
   
   You can also choose Extension Assignment from the ShoreTel button.

2. From the menu, choose the phone to which you want to assign your extension.

   The icon on the Assignment bar changes to indicate the default phone. ShoreTel routes all your calls to this phone.

3. If you want to use a phone that is not listed on the menu, choose Configure Phones.

   The My Phones page of the Options and Preferences window opens for you to configure the phone.

Note

If you have assigned your extension to SoftPhone, when you shut down your computer the extension assignment automatically returns to your primary phone. This is not the case with other devices.
Identifying How Incoming Calls Are Handled

A call handling mode identifies how your inbound calls are handled in a variety of situations. For example, when you are away from your desk you may want to play a different greeting and send incoming calls to another phone number. ShoreTel provides five call handling modes to identify the manner that your calls are handled in a variety of situations: Standard, In a Meeting, Out of Office, Extended Absence, and Custom.

You can configure a call handling mode with warnings about how the Standard call handling mode is being used when starting up ShoreTel Communicator, which users can change your call handling mode, and the definition of each call handling mode. Refer to the section Configuring Call Handling Modes on page 86 for information.

The active call handling mode is automatically determined on the basis of system schedules maintained by your system administrator. You can also:

- Manually set the active call handling mode using ShoreTel Communicator.
- Manually set the active call handling mode through your ShoreTel IP telephone (as explained in the documentation of your specific telephone).
- Automatically set the call handling mode based on Microsoft Outlook appointments, as explained on page 69.

Manually determining a call handling mode from ShoreTel Communicator

1. Click the call handling icon on the Assignment bar.
   You can also choose Call Handling from the ShoreTel Communicator button.
2. From the drop-down menu, select the call handling mode you want for your incoming calls.
   The icon on the Assignment bar changes to indicate the active call handling mode. ShoreTel uses this mode to handle all incoming calls until you manually select a different mode or an automatic mode transition is performed by the system schedule.

Enabling Additional Devices to Ring Simultaneously

Additional devices can ring simultaneously when someone calls your extension or your DID number. When you answer the call on one of the devices, you are connected to the caller and the other devices stop ringing.

Note that if your system has gone down, or you have moved one of the devices, you must reconfigure the devices to enable simultaneous ringing.

Ringing additional devices

1. From the ShoreTel button choose Options.
2. Click Incoming Call Routing from the Options and Preferences window.
   The Incoming Call Routing page is displayed.
3. In the **Ring Additional Phones** area, select the **call handling mode(s)** for which you want additional phones to ring simultaneously. Then choose the configured phone(s) that you want to ring.

4. Click **OK**.

### Allowing Callers to Find You

You can provide callers who are automatically routed to your voice mailbox a way to contact you by using the Find Me feature. Callers listening to your voice mail message can press 1 to request the ShoreTel system to dial up to two alternate numbers. If the ShoreTel system cannot reach you at either of these numbers, the caller can then leave you a voice mail.

#### Using the Find Me feature

1. From the **ShoreTel button** choose **Options**.
2. Click **Incoming Call Routing** from the Options and Preferences window.
3. Use the options in the **Find Me** area to specify if you want callers who are routed to your voice mailbox to be able to contact you. These options are
   - **When callers reach my voicemail and my Call Handling Mode is**. Select the call handling mode(s) for which callers can reach you.
   - **Find me at the following phones**. Specify the first and second phones, in order, to which the call is routed. These can be internal extensions or external phones.
   - **Send incoming Caller ID**. Select if you want the incoming caller’s ID sent to the Find Me destination. The caller ID is displayed before you answer the call.
   - **Enable record caller’s name for Find Me**. Select to prompt the caller to record their name for calls routed to the Find Me destination. The caller’s name is then played before you answer the call. You can then select **Record name even if caller ID is present** to require all callers to record their name, regardless of the availability of their Caller ID. This excludes internal users whose name was previously recorded.
   - **Automatically find me before playing my greeting, instead of caller pressing “1” during greeting**. Select to route calls to the Find Me destination without requiring the caller to press 1.
4. Click **OK**.

### Personalizing Call Handling

You can create personal rules that further define call routing. For example, you may want to:

- Require unidentified callers to announce their name.
- Assign different ringtones for selected callers, such as family or personal contacts.
- Route calls from non-urgent sources directly to voice mail or to another extension.

Personal call handling rules are based on multiple criteria including the time or date a call is received, the caller status, and caller identity. These rules take precedence over the active call handling mode.

Refer to page 87 for information on creating personal call handling rules.

Making Calls

Using ShoreTel Communicator, you can easily make a call to a single contact or make a call to a contact's voice mailbox. Making special calls, usually done by operators, assistants, and call center personnel, is explained in Chapter 7.

ShoreTel Communicator helps reduce your attempts to call unavailable parties by identifying the availability (presence) of a contact to accept your call. For information, refer to the section Identifying Presence on page 54.

Once you have placed a call, details of the connected call are displayed in the Active Call area of ShoreTel Communicator.

Making a Call to a Contact

You can make a call to a contact in several ways. Calls can be made from:

- The Dial menu
- The QuickDialer
- The Contacts, History, and Directory windows
- The Speed Dial window
- An availability alert

You can also make a call from the Voice Mail window, the Chat window, and from Microsoft Outlook.

Making a Call from the Dial Menu

You can make a call from the Dial menu.

1. From the ShoreTel button, choose Dial > Make Call.

2. Use the Make New Call dialog box to enter the call recipient's name or number in the field at the top. Matches from the directory are displayed below as the text is entered.

3. Select the call recipient. The Dial Digits field shows the number that will be dialed.

4. Click Make Call.

Making a Call Using the QuickDialer

The QuickDialer offers rapid access to directories and personal contacts, and provides a quick way to make a phone call.
1. From the QuickDialer field, select the recipient of the call, then choose the phone number you want to use.

**Making a Call from the Contacts, History, and Directory Windows**

The Contacts window list the people, or groups, you call most frequently. The History window displays all previous incoming and outgoing calls. And the Directory window displays information for all system users.

- Double-click on the contact you want to call.
- Right-click on the contact and choose the phone number from the resulting menu.

**Making a Call from the Speed Dial Window**

You use the Speed Dial window to initiate and manage calls to your speed dial contacts.

- Double-click on the contact you want to call.
- Dial the speed dial number associated with the contact.
- Right-click on the contact and choose **Dial** from the resulting menu.

**Making a Call from an Availability Alert**

If you have chosen to receive an alert when a contact becomes available, you can make a call directly from the alert.

**Making a Call to a Voice Mailbox**

If you prefer to leave a voice mail, rather than speaking to a recipient, you can call their voice mailbox.

- From the Contacts or Directory windows, right-click on the recipient and from the resulting menu choose **Dial Mailbox**.
- Choose **Dial Mailbox** from the **Dial** menu. Use the Dial Mailbox dialog box to locate and select the recipient and then click **Dial Mailbox**.

**Answering a Call**

Answering a call is easy with ShoreTel Communicator. You are notified of an incoming call in three ways:

- You hear an audible tone from your default device.
  
  If your default device is your computer, you can select the tone that your computer plays.

- Incoming call information is shown in the Active Call area of ShoreTel Communicator.

- A call alert is displayed.

  Incoming call alerts are displayed by default; if you want to turn off this feature refer to the section Specifying Telephony Options on page 93 for details.
Details on an incoming call are displayed in the Active Call area. Once answered, the details associated with the call change to indicate the connected status of the call.

**To answer a call, you can:**

- Double-click on the call in the Active Call area.
- In the Active Call area, click the **Answer** icon associated with the call,
- In the Active Call area, right-click on the call and select **Answer** from the resulting menu.
- Select the call in the Active Call area, and click **Answer** on the Call toolbar.
- Click **Answer** from an Incoming Call alert. The alert, which appears in the bottom right corner of your monitor screen, indicates the caller’s name and number.

### Transferring Calls

You can transfer a call to another person, number, or device. Once transferred, the call is removed from the Active Call area.

Special types of transfers, usually done by operators, assistants, and call center agents, is explained in Chapter 7.

1. In the Active Call area, click the **Transfer** icon associated with the call.

   You can also:

   - Right-click on the call you want to transfer in the Active Call area and select **Transfer** from the resulting menu.
   - Select the call in the Active Call area, and click **Transfer** on the Call toolbar.

   The call is placed on hold.

2. Using the Transfer dialog box, enter the call recipient’s name or number in the field at the top.

   Matches from the directory are displayed below as the text is entered.

3. Select the call recipient.

   The Dial Digits field shows the number that will be dialed.

4. Click **Transfer**.

### Routing a Call

Instead of answering an incoming call, you can route the call to your voice mail or route the call to the automated attendant.

Once routed, the call is removed from the Active Call area.
Routing a Call to Voice Mail

Generally, you route incoming calls to your voice mail.

- In the Active Call area, right-click on the call you want to route and select **To Voice Mail** from the resulting menu.
- Select the call in the Active Call area, and click **To VM** on the Call toolbar.
- Click **To VM** from an Incoming Call alert. The alert, which appears in the bottom right corner of your monitor screen, indicates the caller’s name and number.

Routing a Call to the Automated Attendant

If you don’t recognize a call, or know that the caller intends to reach someone else, you may want to route an incoming call to your company’s automated attendant.

- In the Active Call area, right-click on the call you want to route and select **To Auto Attendant** from the resulting menu.
- Select the call in the Active Call area, and click **To AA** on the Call toolbar.

Calls on Hold

Placing a call on hold maintains the active status of a call while suspending the conversation. This allows you to make another call or perform other activities without losing the call.

Call details are displayed in the Active Call area, including the length of time the call has been on hold.

If you place a caller on hold and then hang up, your telephone rings once after 10 seconds to notify you that a call is on hold. If this first reminder is ignored, your phone rings on a 60-second interval until you either retrieve or hang up the call.

Placing a call on hold

1. To place a call on hold, double-click on the call in the Active Call area.

2. In the Active Call area, click the **Hold** icon associated with the call.

3. In the Active Call area, right-click on the call you want to place on hold and select **Hold** from the resulting menu.

4. Select the call in the Active Call area, and click **Hold** on the Call toolbar.

To retrieve a call on hold

1. Double-click on the call in the Active Call area.

2. In the Active Call area, click the **Unhold** icon associated with the call.
3. Select the call in the Active Call area, and click **Hold** on the Call toolbar.

**Recording a Call**

You can record conversations using ShoreTel Communicator, if authorized by your system administrator. You can record your own calls or record the calls other system users. A tone informs external callers that the call is being recorded. The recording is placed in your voice mailbox.

Once recording starts, the details associated with the call in the Active Call area changes to indicate that the call is being recorded.

ShoreTel conference calls cannot be recorded. Recording stops when a call is parked, transferred, or the recording is terminated.

**Recording your own calls**

1. Right-click on the call in the Active Call area, and select **Record** from the resulting menu.

2. Choose **Record** from the Call menu.

**Recording other calls**

1. Right-click on the contact whose call you want to record in the Contact window, and select **Record** from the resulting menu.

2. Right-click on the agent whose call you want to record in the Agent Monitor window, and select **Record** from the resulting menu.

3. Choose **Record Extension** from the Call toolbar, to record the conversation of the extension associated with that particular instance of the icon.

**Terminating call recordings**

1. Right-click on the call in the Active Call area, and select **Stop Recording** from the resulting menu.

2. Choose **Stop Recording** from the Call menu.

**Muting a Call**

Using ShoreTel Communicator, you can mute a call so that you can continue to listen to the other party without being heard. To mute a call, select the call in the Active Call area, and click the **Mute** icon on the Assignment bar. The Mute icon changes color to a bright orange. Clicking the Mute icon again unmutes the call and changes the icon color back to blue.
Sending Digits While on a Call

While on a call you may need to send digits, for example to specify a menu choice or enter a conference code. ShoreTel Communicator provides a keypad dialer for this use; you cannot make a call using the keypad dialer.

If you are using a telephone, the keypad dialer is only available for external calls (i.e. calls that are sent to or received from outside the ShoreTel system). If you are using SoftPhone, the keypad dialer is always available.

1. In the Active Call area, right-click on the call to which you want to send digits, and select **Send Digits** from the resulting menu.

   You can also:
   
   - Select the call in the Active Call area, and click the **Send Digits** icon on the Assignment bar.
   - Select the call in the Active Call area, and click **Send Digits** on the Call toolbar.

2. Use the keypad dialer to send the digits you want.

Conference Calls

Conference calls are voice calls that involve more than two parties. ShoreTel supports conference calls with a maximum of six participants. Special types of conference calls, usually done by operators, assistants, and call center agents, is explained in Chapter 7.

After a conference call is created, the Active Call area is updated with details of the conference, including the participants.

You can also drop a participant from a conference or terminate the entire conference.

Initiating a conference call

1. **Make a call** to a conference participant.

2. Once the call is connected, in the Active Call area click the **Conference** icon associated with the call.

   You can also:
   
   - Right-click on the call in the Active Call area and select **Conference** from the resulting menu
   - Select the call in the Active Call area, and click **Conference** on the Call toolbar.

3. Using the Conference dialog box, enter the call recipient’s name or number in the field at the top. Select the call recipient from the directory matches displayed below as the text is entered. The Dial Digits field shows the number that will be dialed. Then click **Transfer**.
4. Add additional participants to the conference call by putting the current participant on hold, and then make a call to an additional conference participant. Once the new call is connected, click the Conference icon associated with that call. Clicking No Thanks leaves the call in progress on hold and allows you to proceed with the new call.

The calls are joined into a single conference call.

**Dropping a participant from a conference**

1. In the Active Call area, click the Hang Up icon associated with the call you want to drop.
2. Right-click on the call in the Active Call area and select Drop from the resulting menu.
3. Select the call in the Active Call area, and click Drop on the Call toolbar.

**Terminating a conference call (all parties)**

1. In the Active Call area, click the Hang Up icon associated with the conference.
2. Right-click on the conference call in the Active Call area and select Hang Up from the resulting menu.
3. Select the conference in the Active Call area, and click Hang Up on the Call toolbar.

After terminating the conference call, place your extension device back on hook.

**Using ShoreTel Web Conferencing**

ShoreTel conferencing allows you to create a conference call with up to 30 participants. You must have authorization from your system manager to use this feature, and need to have a Conference Bridge account.

From the Windows menu, choose Conference Web Portal.

The Conference Web Portal opens in your browser. Refer to the ShoreTel Conferencing User Guide for instructions on using ShoreTel Conferencing.

**Ending a Call**

To end a connected call, choose the Hang Up command or Hang Up icon. Hanging up can be done from:

- In the Active Call area, click the Hang Up icon associated with the call.
- In the Active Call area, right-click on the call you want to end and select Hang Up from the resulting menu.
- Select the call in the Active Call area, and click Hang Up on the Call toolbar.
CHAPTER 3

Working with Voice Mail

Overview .................................................................................................................................................. 35

Using the Voice Mail Window .............................................................................................................. 35
Listening to Voice Mail .......................................................................................................................... 37
Replying to Voice Mail ............................................................................................................................ 37
Managing Voice Mail ............................................................................................................................... 38
Creating New Voice Mail ......................................................................................................................... 40
Managing Distribution Lists ..................................................................................................................... 41
Overview

ShoreTel Communicator provides extensive features to work with your voice mail from within ShoreTel Communicator. These features are:

- Selecting your playback device
- Listening to voice mail
- Replying to voice mail
- Managing voice mail
- Creating a new voice mail
- Managing voice mail distribution lists

Using voice mail options, you can:

- Specify how messages are recorded, played, delivered, and escalated.
- Record a new message.
- Change your voice mail password.
- Identify the sound that plays when a new voice mail is received.
- Choose the language used for voice mail audio prompts.

See the section Specifying Voice Mail Options on page 90 for information.

For information on ShoreTel Communicator voice mail features integrated with Microsoft Outlook, refer to Chapter 6.

You generally work with voice mail using the Voice Mail window.

Using the Voice Mail Window

A list of your voice mails, in the order they are received, is shown on the Voice Mail window. Details on a voice mail include the sender’s name and phone number, when the message was received, and the subject of the message. Unheard messages are displayed in bold, and messages marked urgent are displayed in red. You generally work with voice mail using the Voice Mail window.

Messages are organized into folders. You can select the specific information you want to see in the Voice Mail window. The Voice Mail window also contains the Playback bar to control the audio playback of voice messages.

Opening voice mail

1. Click the Voice Mail tab at the bottom of the Content area.
2. Choose Voice Mail, from the Windows menu.
Voice Mail Window Folders

The Voice Mail window displays all the voice mails you have received organized into three folders:

- Inbox
- Saved
- Deleted

The number associated with each folder indicates the number of unheard messages in that folder.

The Inbox folder lists all the voice messages in your voice mailbox. Messages remain in this folder until moved to the Saved or Deleted folder.

The Saved folder is a repository for messages that were previously received but are not yet ready for deletion. Messages remain in the Saved folder until you delete them or the maximum time limit set by your system administrator is reached.

Messages moved to the Deleted folder remain there until 2:00 am (server) time, when ShoreTel removes messages that are at least 6 hours old. Voice mail messages less than six hours old remain in the Deleted folder until 2:00 a.m. the next day. Messages moved to the Deleted Folder and then subsequently deleted are removed from the system and cannot be recovered. You can restore messages in the Deleted Folder by moving them to the Inbox or Saved folders, after which they are safe from daily maintenance deletion.

Specifying display information in the voice mail

You can select the information you want to see in the Voice Mail window by adding, removing, and changing the display order of the columns in the window. You can also change the sort order of a column.

Note

The urgent and message columns cannot be removed. The GUID column displays an internal message identifier that is used for troubleshooting purposes only.

Selecting Your Playback Device

You can listen to your voice mails using either your computer microphone and speakers, or your telephone. You can also select your playback device using Microsoft Outlook.

1. From the Voice Mail window, click on the playback device icon on the Playback bar.

2. From the drop-down menu, choose either Play via Telephone or Play via PC Speakers. The icon changes to indicate the selected audio device.

Note

If you have forwarded your calls to another phone, such as your mobile phone, choosing Play via Telephone plays the voice mail on that phone.
Listening to Voice Mail

A list of your voice mails, in the order they are received, is shown in the Voice Mail window. Messages that have not yet been heard are displayed in bold. You can listen to your messages using either your computer's speakers or your telephone. ShoreTel Communicator also allows you to control the audio playback of a voice mail.

A voice mail icon, located in the Windows desktop Notification area, indicates if you have any unheard voice message when you move the pointer over the icon.

You can also listen to your voice mail using Microsoft Outlook.

Listening to voice mail from the Voice Mail window

1. Double-click on the voice mail you want to listen to.
2. Select the voice mail and then click the Play button on the Playback bar.

When playing a voice mail using the speakers, a download indicator is displayed to inform the user that the message is being downloaded for playback.

Controlling audio playback of a voice mail

1. From the Voice Mail window, use the Play/Pause and Stop buttons and the cursor, on the Playback bar.

Repeating to Voice Mail

You can reply to a voice mail by voice mail, or by contacting the sender through other methods (i.e. making a telephone call, replying by IM, or sending an email).

Note

You can only reply to a voice mail sent by other ShoreTel Communicator users. You can only reply by telephone if Caller ID is available for a voice mail.

You can also reply to voice mail using Microsoft Outlook.

1. From the Voice Mail window, right-click on the message you want to response to and select Reply or Reply to All from the resulting menu. You can also click Reply from the toolbar.
2. Use the New Voice Mail Message window to create your voice mail response.
Contacting the sender by other methods

1. From the Voice Mail window, click **Contact Sender** from the toolbar.

2. Right-click on the message you want to respond to, and choose the appropriate method from the resulting menu.

   If you are making a telephone call, details on the call are displayed in the Active Call area.

Managing Voice Mail

You can manage and organize your voice mail displayed in the Voice Mail window by:

- Saving messages
- Deleting messages
- Editing the subject heading
- Changing the status of a message
- Forwarding messages
- Exporting messages
- Viewing information about a voice message

Saving Voice Mail

Saving a voice mail moves the message from the Inbox or Deleted folder to the Saved folder.

Note

If Microsoft Outlook is integrated with your voice mail, a voice mail moved into the ShoreTel Communicator Voice Mail window’s Saved folder remains in the Outlook Inbox.

1. From the Voice Mail window, select the voice mail you want to save from the appropriate folder.

2. Click **Save**. You can also right-click on the message, and from the resulting menu choose **Move to Saved Folder**.

   The message is moved to the Saved folder. Messages remain in the Saved folder until you delete them or the maximum time limit set by your system administrator is reached.

Deleting Voice Mail

Voice mail moved to the Deleted folder remains there until 2:00 a.m (server) time, at which point ShoreTel removes all messages that are at least 6 hours old. Voice mail less than six hours old remains in the Deleted folder until 2:00 a.m. the next day.
You can recover messages displayed in the Deleted folder right-clicking on the message, and from the resulting menu choosing either Move to Saved Folder or Move to Deleted Folder. The message is moved into the appropriate folder. Once the message is deleted by the system, it cannot be retrieved. You can delete a voice message while the message is being downloaded.

You can also delete voice mail using Microsoft Outlook.

1. From the Voice Mail window, select the voice mail you want to delete from the Inbox or Saved folder.

2. Click Delete. You can also right-click on the message, and from the resulting menu choose Move to Deleted Folder.

   The message is moved to the Deleted folder.

**Editing the Subject Heading**

By default, all voice mails in the Voice Mail window have the subject heading “Voice Message” and the extension the voice was made from. You can create a more descriptive heading to help you easily identify the subject of the message.

You can also edit the subject of a voice mail using Microsoft Outlook.

1. Click on the Subject field of the message and type the new heading in the active field.

2. Right-click on the voice mail, choose Edit Subject from the resulting menu, and type the new heading in the active Subject field of the message.

**Changing the Message Status**

You can manually change a message status to visually indicate that a message is heard or unheard. Unheard messages are listed in bold in the Voice Mail window.

Moving an unheard voice mail from the Inbox to either the Saved or Deleted folders will mark the message as heard.

1. From the Voice Mail window, right-click the voice mail whose status you want to change.

2. Choose Mark as Heard or Mark as Unheard, as appropriate, from the resulting menu.

**Forwarding a Voice Mail**

Forwarding a voice mail sends the message to another ShoreTel user. Note that you can only forward public voice mails; voice mails that you have received that are marked private cannot be forwarded.

You can also forward voice mail using Microsoft Outlook.

1. From the Voice Mail window, right-click on the message you want to forward and choose Forward from the resulting menu. You can also click Forward from the toolbar.

2. Use the New Voice Mail Message window to specify the recipient(s) of the voice mail.
Exporting a Voice Mail

You can export a voice mail to the audio WAV file format for use by other applications. Note that you can only export public voice mails; voice mails that you have received that are marked private cannot be exported. In addition, this feature may be disabled by your system administrator to further ensure confidentiality.

1. From the Voice Mail window, right-click the voice mail that you want to export.
2. Select Export to .wav File from the resulting menu.
3. Use the Save As dialog box to specify the name and location of the file, and click Save.

Viewing Information on a Voice Mail

Information on a voice mail can be easily viewed from the ShoreTel Communicator Voice Mail window.

1. Right-click on the message you want information on, and choose More Info from the resulting menu.
2. Click More Info from the toolbar.

Creating New Voice Mail

Using ShoreTel Communicator you can create a new voice mail from the Voice Mail window and the Contacts window. You can also use Microsoft Outlook to create a new voice mail. Note that you can only send a voice mail to other ShoreTel users.

Voice messages are recorded using your telephone or a microphone. Voice mails can be created for, and sent to, multiple recipients by selecting a distribution list. For more information on distributions lists, see page 41.

By default, message length is 2 seconds. If you want more time for your voice mails, contact your system administrator.

1. Click New Message.
2. In the New Voice Message window, enter the names of the recipient(s) in the To field.
   
   If you need help finding a recipient, click To. Use the Add/Remove Members dialog box to create and edit a list of recipients (including a distribution list) by selecting a recipient and clicking Add or Remove to move the item into the appropriate list. You can narrow the possible recipients displayed by choosing the appropriate category from the Show Names From drop-down menu. Then click OK.

3. In the Subject field, type the subject of the message.
4. If the message requires immediate attention, select the checkbox for Urgent. You can also select the Private and Return Receipt checkboxes to indicate if the voice message is of a private nature and if you want notification that the recipient has listened to the voice mail.
5. Click the Record button and speak into your microphone or telephone to record your message.
The device you use to record a voice mail is determined by your playback device (see page 36 for details).

6. Click the Stop button when you have finished recording.

7. Use the Play/Pause button and the cursor to review the message.

8. When you are ready to send your recorded message, click Send.

Creating a voice mail using the Contacts window

1. Right-click on the recipient of the voice mail, and from the resulting menu choose Send Message. Use the New Voice Message window to compose and send the voice message.

Use this method if you also want to send the voice mail to additional recipients.

2. If you want to send the voice mail directly to the recipient's voice mailbox, select the recipient of the voice mail, click Dial Mailbox. Then using your telephone or headphone, leave a voice mail.

You can also right-click on the recipient and from the resulting menu choose Dial Mailbox.

Managing Distribution Lists

You use distribution lists to send a voice mail to multiple recipients. Distribution lists appear as a possible recipient when creating a voice mail. You must have authorization from your system administrator to send messages through a distribution list. Distribution lists are indicated by an icon.

ShoreTel Communicator provides two types of distribution lists:

- **System Lists**: A list of extensions created by your system administrator. A Broadcast list is a type of system list that contains every extension in the system.

- **Personal Lists**: A list created by you for the recipients of a voice mail.

Managing distribution lists involves:

- Creating a new distribution list
- Recording a prompt
- Viewing the list members
- Editing a distribution list
- Deleting a distribution list

Creating a New Distribution List

You can only create user-defined distribution lists.
1. Right-click in the Voice Mail window, and choose Distribution Lists from the resulting menu. You can also click Lists on the toolbar.

2. In the Distribution Lists dialog box, click New.

3. Use the Distribution List Details dialog box to specify the distribution list name, identification number, and members. Then click OK.

**Recording a Distribution List Prompt**

A distribution list prompt announces the name of the distribution list to recipients. You can only record a prompt for the distribution lists you have created.

1. Right-click in the Voice Mail window, and choose Distribution Lists from the resulting menu. You can also click Lists on the toolbar.

2. In the Distribution Lists dialog box, select the distribution list, and click Prompt.

   Lists that you created are denoted with a leading # sign in the number field.

3. Use the Prompt Recorder to create your prompt, and then click OK.

   The controls are similar to the Playback bar, as described in the sections Selecting Your Playback Device on page 36 and Listening to Voice Mail on page 37.

**Viewing the Members of a Distribution List**

You can view the members of any type of distribution list.

1. Right-click in the Voice Mail window, and choose Distribution Lists from the resulting menu. You can also click Lists on the toolbar.

2. In the Distribution Lists dialog box, select the distribution list, and click Edit/View.

   Lists that you created are denoted with a leading # sign in the number field. Broadcast lists have the name Broadcast. System lists are associated with an extension in the number field.

   If the distribution list is a broadcast or system list, a non-editable Distribution List Details window opens with information on the list.

   If the distribution list is one you created, an editable Distribution List Details window opens with information on the list.

**Editing Distribution Lists**

You can change the members of a distribution list you created.

1. Right-click in the Voice Mail window, and choose Distribution Lists from the resulting menu. You can also click Lists on the toolbar.

2. In the Distribution Lists dialog box, select the distribution list, and click Edit/View.

   Lists that you created are denoted with a leading # sign in the number field.
3. Use the Distribution List Details window to add or remove members from the list, and then click OK.

Deleting Distribution Lists

You can delete a distribution list you created.

1. Right-click in the Voice Mail window, and choose Distribution Lists from the resulting menu. You can also click Lists on the toolbar.

2. In the Distribution Lists dialog box, select the distribution list, and click Delete.

   Lists that you created are denoted with a leading # sign in the number field.
CHAPTER 4

Instant Messaging, Email, and Video

Overview ................................................................................................................... 45
Using Instant Messaging........................................................................................... 45
   The Chat Window ............................................................................................... 46
   Initiating an IM Session ...................................................................................... 46
Using Email ............................................................................................................... 49
Using Video ............................................................................................................. 50
Overview

In addition to voice mail, ShoreTel Communicator makes it possible to easily communicate using instant messaging, email, and video.

Using Instant Messaging

Instant messaging (IM), also known as chat, is the real-time transmission of text between two or more ShoreTel Communicator users. You can participate in multiple simultaneous IM sessions. The features of ShoreTel Communicator IM are:

- Initiating an IM session.
- Joining an IM session.
- Adding participants to an IM session.
- Saving the transcript of an IM session
- Permitting IM from a contact.
- Requesting IM privacy permission.
- Making a voice call from an IM session.
- Ending an IM session

You can customize your IM experience by:

- Displaying an incoming IM alert.
- Specifying the sound that your computer plays when it receives an instant message.
- Double-clicking on a a contact in the Contact window to initiate an instant message
- Specifying which information, and how it is to be shown, in the Chat window.
- Automatically saving all transcripts of your IM sessions to a specific location.

For details, see the section Specifying Instant Messaging Options on page 94.

Information on ShoreTel Communicator’s Presence feature, which you can use to inform colleagues of your, and be informed of their, availability to engage in IM and voice calls can be found in Identifying Presence on page 54.

You use the Chat window to send and receive IM messages.
The Chat Window

The Chat window allows you to send and receive IM messages. This window is displayed when you initiate an IM session or when you receive the first message of an IM session.

By default, a separate Chat window opens for each current IM session. You can instead choose to have a single Chat window for all your sessions and to be warned before closing the single Chat window with multiple sessions. If using a single window, you toggle between sessions by clicking on the appropriate chat tab.

The party with whom you are chatting is displayed at the top of the window. Exchanged text is shown in the Text panel, preceded by the name of the party that sent the message. The Input panel displays text, as you type, that you are preparing for the other chat participant(s). You can move the separator to adjust the size of the Input panel.

To show information on when a message was sent or received (timestamp), from the View menu choose Show Timestamp. Timestamp information can also be displayed automatically for all messages by selecting the appropriate option. The Status bar displays messages, for example that the other participant is typing text.

Initiating an IM Session

You can start an IM session with any ShoreTel system user. If the contact is offline, or has assigned you a Blocked IM privacy permission, you see the error message “Failure to send message” in the Chat window.

You can also initiate an IM session from Microsoft Outlook.

1. Select a contact in the Contacts window and click IM from the window toolbar.

You can also
- Double-click on a contact in the Contacts window, if you have selected the option **Initiate instant messaging when double clicking on a contact in the Contact pane**.

- Right-click on a contact from the **Contacts, History, Voice Mail, and Directory** windows, and from the resulting menu choose the contact’s IM address.

- Use the **QuickDialer**, to locate and select a contact’s IM address.

- From the **Active Call area**, select a call to which you want to add IM and click the **IM** icon associated with the call.

- Click **IM** from an Availability alert.

- Click **Send IM from** an **Incoming Call alert**.

  2. Use the Chat window to participate in an IM session with the contact by typing your message in the **Input panel** and clicking **Send**.

### Joining an IM Session

When an IM session is initiated from one of your contacts with the **IM privacy permission of Allowed**, the minimized Chat window opens and flashes in Windows taskbar.

If you have selected the **Show Incoming Alert Message** option, an alert appears in the bottom-right corner of your monitor

1. Click on the minimized Chat window in the taskbar, or anywhere in the alert to maximize or open the Chat window.

2. Use the Chat window to participate in the IM session by typing your message in the **Input panel** and clicking **Send**.

### Adding Participants to an IM Session

An IM session can include two to six participants.

1. In the Chat window, enter the IM address, name, or number of the new participant in the **Add Participant** field.

2. Press **Enter**. The new participant is added to the Session Participant list.

  Subsequent messages are sent to all contacts listed in the Session Participant list.

### Saving the Transcript of an IM Session

Saving the transcript of an IM session allows you to retrieve the messages if needed. You can save the transcript of an individual session, or **automatically save the transcripts of all your IM sessions to a specific location** by selecting the appropriate option.

1. From the Chat window, click the **Save** icon.

2. Use the resulting dialog box to specify a name and location for the transcript, and then click **Save**.
Permitting IM

Before engaging in an IM session, you must specifically permit a contact to communicate with you in this way. This is done by:

- Specifying your IM privacy permissions for a contact.
- Responding to a request for IM privacy permission.
- Viewing and changing a contact’s IM privacy permission.

Specifying IM Privacy Permissions

By specifying an IM privacy permission for a contact, you identify with whom you want to receive IM.

The following privacy permissions are available:

- **Allowed.** The contact can view your IM presence status and send you an IM request.
- **Blocked.** The contact is denied access to your IM presence status and cannot send you an IM request. The contact sees your IM presence status as Offline.
- **Pending.** You have not responded to a contact’s request for your IM presence status.

1. From the **Contacts** window, right-click on a contact and from the resulting menu choose **IM Privacy** and then the privacy setting you want to assign to the contact.

2. Use the **Options > Instant Messaging > Privacy > Permissions** list, as described in the section Specifying Instant Messaging Options on page 94.

Responding to an IM Privacy Permission Request

You participate in IM sessions only with those contacts who have the **Allowed** IM privacy permission. Colleagues can request this permission, in which case an alert notifies you of the request.

1. From the alert, select the contact(s) you want to see your IM presence and with whom you want to communicate using IM.

   The IM privacy permission for the selected contact(s) will be changed to **Allowed.** All other contacts in the list will have an IM privacy permission of **Pending.**

2. If you want to add the selected contact(s) to your **Contacts** window, select **Add checked names to my Contact list.**

3. To avoid this alert in the future, select **Always accept future requests.**

4. If you want to change any of your Privacy options, click **Settings.**

   The **Options and Preferences > Instant Messaging > Privacy page** opens. Use this page to make changes to your Privacy options.

5. Click **OK.**
Viewing and Changing IM Privacy Permissions

You can view and change IM privacy permissions using either the Contact window or the Options > Instant Messaging > Privacy > Permissions list, as described in the section Specifying Instant Messaging Options on page 94.

1. Right-click on a contact and from the resulting menu choose IM Privacy. The current IM privacy permission is displayed with a checkmark.

2. To change the IM privacy permission, choose the privacy setting you want to assign to the contact.

Requesting IM Privacy Permission

You request IM privacy permissions from those colleagues whose IM presence status you want to see, and with whom you want to engage in IM. You do so by adding the colleague to your Contacts window.

Once you have added the colleague to your Contacts window, they receive an alert notifying them of your request. Your colleague can then decide whether to assign you an IM privacy permission that allows you to see their IM presence status and engage in IM, or not.

When you initiate an IM session, if your colleague has assigned you an IM privacy permission of Allowed, you can use the Chat window to engage in the session. If instead your colleague has assigned you a Blocked IM privacy permission, or is offline, you see the error message “Failure to send message” in the Chat window.

Making a Call from an IM Session

You can make a voice call to a participant of an IM session.

1. From the Chat window, click the Call Participants icon.

   The call is placed. Information on the call is displayed in the ShoreTel Communicator Active Call area.

Ending an Instant Message Session

Closing a Chat window terminates the IM session and erases all text, unless the transcript from the session has been saved. If multiple sessions are displayed in a single Chat window, end a specific session by closing the tab listing that session.

Using Email

With ShoreTel Communicator, you send an email using your default email application. You can send email from the following locations in ShoreTel Communicator:

- QuickDialer. Use the QuickDialer to locate the recipient of the email, then select their email address.
- **Contents, Directory**, and **Voice Mail** windows. Right-click on the contact to whom you want to send an email, and from the resulting menu choose their email address.

- **History** window. Right-click on the contact to whom you want to send an email. From the resulting menu choose the contact’s phone number and then their email address.

  You default email application’s window for composing email is automatically opened.

---

**Using Video**

Using ShoreTel Communicator’s video feature, you can:

- Add video to a voice call.
- Accept a voice call with video.
- Join a video conference with LifeSize®
- Put a voice call with video on hold.
- Transfer a voice call with video.
- End a video session.
- Define how video requests are handled and identify the video camera you want to use; refer to the section *Specifying Video Options on page 96* for information.

**Note**

ShoreTel Communicator does not support video-only calls, video sessions established with SoftPhone, or when ShoreTel Communicator is accessed through remote desktop.

---

Many video devices provide options to compensate for poor light conditions. Enabling these options may impact the frame rate of the camera. Using optimal light conditions is essential to ensure a good image quality and a proper frame rate when making video calls. Contact your system administrator for a list of video cameras currently supported by ShoreTel.

You participate in a video session using the Video window.

---

**Using the Video Window**

You use the video window to participate in a video session. This window is displayed when you add video to a call or when you receive a call with video. The Video window contains two ports to display both call participants; you are displayed in the smaller port. Click the **Hide Preview** button if you only want to see the other participant and close the port showing you.
Adding Video to a Call

Video can be added to either an active voice call or established as a part of a new voice call. You can only add video to a call if the following conditions are met:

- Both you and the recipient have a video camera.
- Both you and the recipient have authorization from your system administrator.
- The recipient is part of the ShoreTel system.
- The recipient does not have the \textit{Never Accept Video Requests from Others} option selected, as explained in the section \textit{Specifying Video Options} on page 96.

1. In the Active Call area, click the \textbf{Add Video} icon associated with the call to which you want to add video.

You can also:

- Right-click on the call, and choose \textbf{Add Video} from the resulting menu.
- Select the call, and click \textbf{Add Video} on the Call toolbar.

The Video window opens, showing the video participant(s).

Accepting a Call with Video

By default, the system automatically prompts you to agree to add video to a call. You can change this default so that you no longer receive a prompt and the video window opens automatically when the call is connected, or to never receive the video portion of a call. See the section \textit{Specifying Video Options} on page 96 for details.

Joining a Video Conference with LifeSize

If your company uses LifeSize high definition video communications products, you can use ShoreTel Communicator to join a video conference. Contact your system administrator to determine if you can use this feature.

1. Make a call to the video conference number.
2. Add video to the call.
   The Video window opens, showing the video participant(s).

## Putting a Video on Hold

If you are engaged in a voice call with video, you can put the call on hold. Both the audio and video portions of the call are put on hold.

**Note**
The Hold feature is not available if the video call is made over a SIP tie trunk.

1. In the Video window, click **Hold**.
2. To retrieve the video on hold, click **Answer**.

## Transferring a Voice Call with Video

You can transfer a call with video to another person if the following conditions are met:

- The transfer recipient has a video camera.
- The transfer recipient has authorization from the system administrator.
- The transfer recipient is part of the ShoreTel system.
- The transfer recipient does not have the **Never Accept Video Requests from Others** option selected, as explained in the section **Specifying Video Options on page 96**.

Once transferred, the call is removed from the Active Call area.

1. In the Video window, click **Transfer**.
2. Use the Transfer dialog box to locate and select the transfer recipient, and then click **Transfer**.

   Your Video window closes.

## Ending a Video Session

If you want to end both the audio and video portions of a call, in the Video window click **Hangup**. To end only the video portion of a call, close the Video window.
CHAPTER 5

Presence and Contacts

Overview ................................................................................................................... 54
Identifying Presence ............................................................................................. 54
Organizing Contacts ............................................................................................ 57
Overview

ShoreTel Communicator allows you to identify the presence (availability) of yourself and other users before receiving or making calls and engaging in IM sessions. And you can organize your contacts in the ShoreTel Communicator content windows to make it faster and easier to find the contacts and information you want.

Identifying Presence

With ShoreTel Communicator, you can identify a contact’s presence to accept voice calls, IM sessions, or both. Using presence increases your productivity by reducing attempts to connect with unavailable parties, and blocks unwanted attempts to engage in IM.

ShoreTel Communicator automatically adjusts the presence status of users as they make and receive calls, and engage in and end IM sessions; users can also manually set their presence status. Icons, which can be viewed throughout ShoreTel Communicator and Microsoft Outlook integrated with Communicator, identify the presence status of a contact. And you can choose to receive an alert when a contact becomes available and provide additional information on your IM presence status.

Note

In order to view a contact’s presence status in Microsoft Outlook integrated with Communicator, make sure to start ShoreTel Communicator first before starting Outlook.

Presence Icons

Icons identify the presence status of a contact, and your own presence. There are three types of presence icons that represent availability to engage in voice calls, IM sessions, or both voice calls and IM sessions.

Presence Icons for Voice Calls

The following icons indicate voice call presence:

- Available
- Busy
- On the Phone
- Do Not Disturb. Calls are automatically forwarded to the recipient's voice mail
- Unknown.
Presence Icons for IM

The following icons indicate IM presence:

- Available
- Busy or On the Phone
- Away or Be Right Back
- Do Not Disturb
- Offline or IM Address Unknown
- No IM Address

Presence Icons for Combined Status

The following icons indicate both voice call and IM presence:

- Available
- Available for a phone call only
- Do Not Disturb
- On the Phone
- Do Not Disturb with a phone call
- Away
- Busy
- Busy on the phone
- Offline
- Unknown
**Viewing Presence Status**

You can view a colleague's presence status throughout ShoreTel Communicator:

- **The Contacts window.** The presence of a user is displayed by icons associated with the contact, and in the Extn Status and IM Status columns.
- **The Dial > Make Call > Make New Call dialog box.** The presence of a user is displayed by icons associated with the contact.
- **The QuickDialer.** The presence of a user is displayed by icons associated with the contact.

**Receiving an Alert on Availability**

You can receive an alert when a contact becomes available to receive a phone call or participate in an IM session.

1. From the **Contacts** window, right-click on the contact whose availability you want notification.
2. From the resulting menu, choose **Alert When Available**.
3. If you want to be notified again after a specific amount of time, click **Snooze**. To change the amount of time before being notified, click the drop-down menu and choose the appropriate time frame.
4. To place a call to the contact, click **Call**; to start an IM session, click **IM**.

**Manually Setting Your Presence Status**

ShoreTel Communicator automatically adjusts your presence status as you use the system. You can also manually set your IM presence status to indicate your availability. Manually setting your IM presence status informs other users of whether you can or want to engage in an IM session.

1. From the ShoreTel Communicator button, choose **IM Presence** and then the IM status that you want.

**Providing Additional Information on Your IM Status**

You can attach a note to your IM presence to further explain your status. This information appears in the IM Status column of your colleagues’ Contacts window, along with your current state.

1. Click the presence icon on the Accessibility bar, and from the drop-down menu choose **Set Status Note**.
   You can also choose **Set Status Note** from the ShoreTel Communicator button > **IM Presence** command.
2. Use the resulting dialog box to enter your note and then click **OK**.
Organizing Contacts

Organizing your contacts in the ShoreTel Communicator content windows makes it faster and easier to find the contacts and information you need. You can organize your contacts by:

- Uploading your contacts
- Adding, editing, and deleting contacts
- Grouping contacts
- Searching for a contact
- Changing how you view contacts
- Changing the sort order
- Working with columns
- Exporting contacts

Uploading Your Contacts

Using ShoreTel Communicator, you can upload your personal contacts from Microsoft Outlook and a comma-separated values (.csv) or XML file onto the ShoreTel server. Uploading your personal contacts makes these contacts accessible from other versions of ShoreTel Communicator you are using, for example ShoreTel Communicator for iPhone.

Uploading Contacts from Microsoft Outlook

You can display your Microsoft Outlook contacts in ShoreTel Communicator. If enabled by your system administration, and if the option Upload Personal Contacts is selected (by default), your personal Outlook contacts are uploaded onto the ShoreTel server and displayed in ShoreTel Communicator.

If you want to remove all your personal Outlook contacts from ShoreTel Communicator, and no longer upload them in the future, unselect the Upload Personal Contacts option.

Note

If your uploaded contacts do not appear in Outlook, use the following workaround:

1. From the Options > Outlook page, unselect the Upload Personal Contacts option, and then click Apply.
2. Reselect the Upload Personal Contacts option, and click OK.

Uploading Contacts from a CSV or XML File

Contact your system administrator if you want to upload contacts from a CSV or XML file. You must have the option Upload Personal Contacts selected.
Adding, Editing, and Deleting Contacts

You can add, edit, and delete contacts from the Contacts, Directory, History, and Speed Dial windows.

Working with Contacts in the Contacts Window

Directory window contacts and personal contacts can be added to, and deleted from, your Contacts window. The information displayed for a personal contact in the Contacts window can also be edited.

Adding a contact from the Directory window

1. Right-click on the contact in the Directory window, and from the resulting menu choose Add as a Contact. Then choose the contact group to which you want to add the contact.
2. Drag a Directory window contact into the desired group in the Contacts window.

Adding a personal contact

1. Click the Add icon on the Contacts window toolbar. You can also right-click in the window and from the resulting menu choose Add Contact.
2. In the Add Contact dialog box, enter the name or phone number of the contact in the Contact field, and choose the group for the contact from the Group drop-down menu. Then click OK.
3. Use the resulting dialog box to specify additional information on the contact and then click OK.

The default phone number is the number that is called when you double-click on a contact. You can change the default phone number by clicking in the Default field and choosing the number you want from the drop-down menu.

The contact is added to the Contacts window in the group specified.

Editing a personal contact

1. Right-click on the contact and from the resulting menu choose More Info.
2. In the Contact Properties dialog box, edit the desired fields. Then click OK.

Deleting a contact

1. Right-click on the contact and from the resulting menu choose Delete.

The contact is removed from the Contacts window. If the contact is part of the ShoreTel system, the contact remains in the Directory window.

Working with Contacts in the Directory Window

You can add, edit, and delete (only) personal contacts in the Directory window. Contacts that are part of the ShoreTel system cannot be added, edited, or deleted.

Your Outlook contacts can also be automatically added to the Directory window, as explained in the section Enabling Microsoft Outlook Integration Features on page 92.
Deleting Records from the History Window

If you want to delete only specific records, select the records, right-click, and from the resulting menu choose **Delete Record(s)**. To delete all records, right-click in the History window and from the resulting menu choose **Clear History**.

Working with Contacts in the Speed Dial Window

In addition to adding, editing, and deleting contacts from the Speed Dial window, you can also rearrange the order of the contacts in the list.

Grouping Contacts

Contacts can be grouped in the Contacts window. Grouping helps you organize and find your contacts.

The Contacts window requires at least one group; by default this group is named Contacts. A contact can be put into multiple groups; groups cannot contain subgroups. When you first start ShoreTel Communicator, the Contacts window displays an explanation of contacts and how they can be added to this window. You can **add**, **rename** and **delete** groups from the Contacts window.

Adding a group

1. Right-click in the Contacts window, and from the resulting menu choose **Add Group**.
2. Use the Add Contact Group dialog box to specify the name of the new group, and then click **OK**.
3. Add contacts to the new group by either selecting and dragging existing contacts into the group, or by creating a new contact.

Renaming a group in the Contacts window

1. Right-click on the group you want to rename, and from the resulting menu choose **Rename Group**.
2. Use the Rename Contact Group dialog box to specify the new name for the group, and then click **OK**.

Deleting a group from the Contacts window

1. Right-click on the group you want to delete, and from the resulting menu choose **Delete Group**.

Searching for a Contact

You can easily search for a specific contact in a window. You search by a contact’s first name, last name, or phone number. For the Directory window (only), you can also search by company name if the appropriate option is selected.
Changing Contact Views

You can change how you view contacts in the Contacts window.

1. Right-click in the Contacts window and from the resulting menu choose one of the following options:
   - **Details.** Shows information on a contact’s phone number, extension status, current call handling mode, and alert status.
   - **List.** Displays the contact’s name and presence status. The List view is the default.
   - **Small Icons.** Organizes the contacts into a single list (i.e. not grouped), and displays their presence status using small icons.
   - **Large Icons.** Organizes the contacts into a single list (i.e. not grouped), and displays their presence status using large icons.

Changing the Order of Contacts

You can change the sort order of contacts in a window by clicking on columns headings with an arrow.

Working with Columns

Information in most content windows are organized in columns. In these windows, you can add, move, resize, and delete columns to display the information in the way you need.

**Adding a column**

1. Right-click in the window and from the resulting menu choose **Choose Columns**.
2. From the dialog box, drag the column you want to add to the desired location in the column heading area of the window.

**Moving a column**

1. Click and hold the heading of the column to be moved.
2. Drag the column to the desired location in the column heading area of the window.

**Resizing a column**

1. Right-click in the window and from the resulting menu choose **Fit Column Widths to Text**.
   The size of the columns are automatically resized to show fully all information.

**Deleting a column**

1. Click and hold the heading of the column to be deleted.
2. Drag the column from the window until a large X appears on the column.
Exporting Contacts

ShoreTel Communicator allows you to export your contacts for use in another application, like Microsoft Excel. Note that contacts that have been exported cannot be imported back into ShoreTel Communicator.

Contacts can be exported to a tab-delimited file and a CSV file.
CHAPTER 6

Microsoft Outlook with ShoreTel Communicator

Overview ................................................................. 63
Enabling Outlook Integration .................................... 63
Working with Outlook Contacts in ShoreTel Communicator .......... 64
Using Outlook with Voice Mail ................................ 64
Viewing Presence Status in Outlook ............................ 68
Making a Call and Initiating IM ................................. 68
Creating and Joining a ShoreTel Web Conference .............. 69
Automatically Setting Call Handling Using Outlook ............ 69
Overview

ShoreTel Communicator integrates with Outlook’s email, contacts, voice mail and calendar features. This integration makes it possible to work with your Outlook contacts in ShoreTel Communicator. In addition, from Outlook you can:

- Display and listen to your voice mail.
- View a contact’s presence status.
- Make a call and initiate IM.
- Create and join a ShoreTel Web conference.
- Automatically set your call handling mode based on Outlook calendar appointments.

Before using these features you must enable Outlook integration.

Note
ShoreTel Communicator can only be integrated with Outlook 2007 SP2 and Outlook 2010 SP1, both 32-bit and 64-bit.

Enabling Outlook Integration

Before you can use the features provided by integrating Microsoft Outlook with ShoreTel Communicator, you must enable Outlook integration.

1. From the ShoreTel button, choose Options.
2. From the Options and Preferences window, click Outlook. The Outlook page is displayed.
3. Select the appropriate Contact Upload options. These options are
   
   - **Upload Personal Contacts.** Uploads your personal Outlook contacts to the ShoreTel server, so that these contacts are available to Communicator.
   - **Upload Options.** Select the Outlook folder(s) from which the personal contacts are uploaded.
   - **Open Outlook contacts when calls arrive.** The Outlook Contacts form opens when you receive a call from an Outlook contact.
4. To turn on your voice mail integration with Outlook, close Outlook and from the Voice Mail area click Install.

Note
Both Outlook and Communicator need to be installed to integrate voice mail with Outlook.

5. To turn on calendar integration, close Outlook and from the Calendar area click Install.
Calendar integration enables your call handling mode to be updated by Outlook, and the ability to work with ShoreTel Web conferences from within Outlook.

**Note**
Both Outlook and Communicator need to be installed to enable calendar integration.

6. If you want your active call handling mode to be automatically changed based on appointments in the Outlook calendar, select **Use Outlook appointments to change Call Handling Mode**. Calendar integration (i.e. step 4) must be installed to use this option.

You also need to turn on call handling mode in Outlook, as explained in the section **Automatically Setting Call Handling Using Outlook** on page 69.

7. Click **OK**.

**Working with Outlook Contacts in ShoreTel Communicator**

Once you have enabled Outlook integration, you can work with your Outlook personal contacts in ShoreTel Communicator. This allows you to communicate with contacts that are not part of the ShoreTel system.

Outlook personal contacts in ShoreTel Communicator are listed in the Directory window’s Data Source column as **Outlook Personal**.

**Using Outlook with Voice Mail**

ShoreTel Communicator can integrate your voice mail with Outlook. From within Outlook you can:

- Select your playback device
- Listen to a voice mail
- Reply to a voice mail
- Create a new voice mail
- Forward a voice mail
- Edit the subject of a voice mail
- Delete a voice mail
- Move a voice mail into another folder
Your voice mails are listed in the Outlook Inbox. Voice mails are indicated by a cassette icon, and include the phone number or extension of the sender. Unheard messages are displayed in bold; a red exclamation point is associated with urgent messages.

If you are upgrading from a previous version of ShoreTel Communicator, new voice mail items are displayed in the Outlook Inbox for previously existing voice mails, resulting in duplicate items. You can delete the older duplicate voice mails, since these items no longer contain the voice message.

You work with voice mail in Outlook using the ShoreTel Outlook Voice Mail form.

Using the ShoreTel Outlook Voice Mail Form

Double-clicking on a voice mail in the Outlook Inbox opens the ShoreTel Voice Mail form, which you use to work with voice messages.

The ShoreTel Voice Mail form is also displayed in the Preview pane of the Outlook Inbox when a voice mail is selected.

Selecting Your Playback Device

You can listen to your voice mails using either your computer speakers or telephone.

1. From the ShoreTel Voice Mail form > ShoreTel Voice Mail tab > Playback bar, use the playback device icon to select your playback device.

Listening to a Voice Mail

A list of your voice mails, in the order they are received, is shown in the Outlook Inbox. Messages that have not yet been heard are displayed in bold. You can listen to your messages using either your computer's speakers or your telephone.

- From the Outlook Inbox, select or double-click the voice mail that you want to hear. Click the Play button of the Playback bar displayed in the Outlook Preview pane.
  
  or

- From the Outlook Inbox, double-click the voice mail that you want to hear. From the ShoreTel Voice Mail form > ShoreTel Voice Mail tab > Playback bar, click the Play button.

To control the audio playback, use the Play/Pause and Stop buttons, and the cursor, on the Playback bar.

Replying to a Voice Mail

Using Outlook, you can reply to a voice message by voice mail or telephone call.

Note

You can only reply to voice mails sent by users of ShoreTel Communicator.
Repying by voice mail

1. From the Outlook Inbox, select the voice mail you want to reply to, and click Reply or Reply to All.

   If the ShoreTel Voice Mail form is already open for the voice mail to which you want to reply, select the ShoreTel Voice Mail tab and then click Reply or Reply All.

2. In the resulting window, use the To field to add or remove recipients, and the Subject field to change the subject of the new voice mail.

3. To include the original voice mail with your response, click Include Original. If the message requires immediate attention, click Urgent. You can also click Private and Return Receipt to indicate if the voice message is of a private nature and if you want notification that the recipient has listened to the message.

   Voice mails marked private cannot be forwarded to another party.

4. Click the Record button and speak into your telephone to record your message.

5. Click the Stop button when you have finished recording.

6. Use the Play/Pause button and the cursor to review the message.

7. When you are ready to send your recorded message, click Send.

Repying with a telephone call

1. From the Outlook Inbox, double-click on the voice mail you want to reply to.

2. In the ShoreTel Voice Mail form > ShoreTel Voice Mail tab, click Contact Sender.

   The call is placed and details on the call are displayed in the Active Area of ShoreTel Communicator.

Creating a New Voice Mail

Using Outlook, you can create a new voice mail. The process differs slightly depending on whether you are using Microsoft Outlook 2007 or Microsoft Outlook 2010.

1. (For Outlook 2007) – From the File menu, choose New > Choose Form.

1. (For Outlook 2010) – From the Home tab, click New Items > Custom Forms > ShoreTel Voicemail Form.

2. In the Choose Form dialog box, select ShoreTel Voice Mail Form and click Open.

3. Use the ShoreTel Voice Mail form to compose and send the voice mail.

Forwarding a Voice Mail

You can forward a voice mail to another voice mailbox and as an attachment.
You can only forward a voice mail to a ShoreTel user’s mailbox. If you want to send a voice mail to someone outside of the ShoreTel system, send it as an attachment. Note that you cannot forward a private voice mail (i.e. a voice mail marked as private by the original sender).

**Forwarding voice mail to another voice mailbox**

1. From the Outlook Inbox, double-click on the voice mail you want to forward.

2. In the **ShoreTel Voice Mail form > ShoreTel Voice Mail** tab, click **Forward**.

3. Use the resulting window to choose the specifics of the voice mail.

**Forwarding voice mail as an attachment**

1. From the Outlook Inbox, double-click on the voice mail you want to forward.

2. In the ShoreTel Voice Mail form > **ShoreTel Voice Mail** tab, click **Forward as Attachment**.

3. A new email is created with the voice mail attached as an audio WAV file.

4. Compose and send the email message.

**Editing the Subject of a Voice Mail**

You can edit a voice mail subject to provide a more meaningful description of the voice mail.

- From the Outlook Preview pane, click on the Subject field of the message, and type the new heading in the active field.

  or

- From the Outlook Inbox, double-click on the voice mail whose subject you want to edit. In the **ShoreTel Voice Mail form > ShoreTel Voice Mail** tab, click **Edit Subject**. Type the new subject of the voice mail. Then **Save**.

**Deleting a Voice Mail**

You can delete a voice mail from within Outlook.

- From the Outlook Inbox, select the voice mail you want to delete, and click **Delete**.

If the ShoreTel Voice Mail form is already open for the voice mail you want to delete, from the ShoreTel Voice Mail tab click **Delete**.

The voice mail is moved into the Outlook Deleted Items folder. The voice mail remains in the Deleted Items folder until 2:00 am (server) time, when ShoreTel removes messages that are at least 6 hours old. Voice messages less than six hours old remain in the Deleted Items folder until 2:00 a.m. the next day. Messages removed from the system cannot be recovered. You can restore messages in the Deleted Items folder by moving them back to the Inbox folder, after which they are safe from daily maintenance deletion.
Moving a Voice Mail

Just like with email, you can move a voice mail to another Outlook folder. However, when a voice mail is moved into a folder, the original voice mail remains in the Inbox and an email item is created in the folder with a copy of the voice mail attached as a WAV file.

- From the Outlook Inbox, select the voice mail you want to move and drag it into another folder.

Viewing Presence Status in Outlook

A contact’s presence status indicates their availability to engage in IM and voice calls. Presence status icons are displayed in Outlook next to a contact’s name.

In order to view a contact’s presence status in Outlook, make sure to start ShoreTel Communicator first before starting Outlook.

Information on ShoreTel Communicator’s Presence feature, including the description of the presence icons, can be found in Identifying Presence on page 54.

Making a Call and Initiating IM

With ShoreTel Communicator integrated with Outlook, you can make a voice call and initiate IM using ShoreTel Communicator from Outlook.

- From the Outlook Inbox, select the contact you want to call. Select the Home tab > More button. From the drop-down menu, choose Call. If the contact has more than one phone number in the system, choose the phone number you want to call from the resulting drop-down menu. or

- Rest your cursor (hover) over a contact name that displays a presence indicator. From the Contact Card, click the Phone icon. If the contact has more than one phone number in the system, choose the phone number you want to call from the drop-down menu.

The call is placed. Details on the call are displayed in the ShoreTel Communicator Active Call area.

Initiating IM from Outlook

- From the Outlook Inbox, select the contact with whom you want to initiate. Select the Home tab > IM button. From the drop-down menu, choose Reply with IM or Reply All with IM.

- Rest your cursor (hover) over a contact name that displays a presence indicator. From the Contact Card, click the IM icon.

- From the ShoreTel Voice Mail form > ShoreTel Voice Mail tab, click IM. From the drop-down menu, choose Reply with IM or Reply All with IM.

The Chat window opens. Use the Chat window to participate in the IM session by typing your message in the Input panel and clicking Send.
Creating and Joining a ShoreTel Web Conference

You can create and join a ShoreTel Web Conference from an open Outlook calendar appointment, if you have enabled calendar integration.

Refer to the ShoreTel Conferencing User Guide for detailed information on ShoreTel Web Conferencing.

Creating a ShoreTel conference

1. From an open Outlook calendar appointment, click Conference.

   A new conference is automatically created and details on the conference are displayed in the body of the appointment.

2. When you are ready to start the conference, open the appointment and click Join Conference.

   The ShoreTel conference window opens in your browser.

Joining ShoreTel conference

1. From an open Outlook calendar appointment with a ShoreTel conference, click Join Conference.

   The ShoreTel conference window opens in your browser.

Automatically Setting Call Handling Using Outlook

A call handling mode identifies how your inbound calls are handled in a variety of situations. ShoreTel provides five call handling modes: Standard, In a Meeting, Out of Office, Extended Absence, and Custom.

The active call handling mode is automatically determined on the basis of system schedules maintained by your administrator. You can also have your call handling mode automatically set based on appointments in your Outlook calendar.

1. Make sure you have selected the Use Outlook appointments to change Call Handling Mode option and installed calendar integration.

2. Enable call handling mode in Outlook by choosing from the Outlook File menu > Options > Add-Ins. In the View and Manage Microsoft Office Add-Ins dialog box, click Add-in Options. Use the options in the ShoreTel Call Handling tab of the Add-in Options dialog box to and then click OK. These options are

   - Use Outlook Calendar to schedule Call Handling. If selected, turns on the feature.
   - Work Week Call Handling Mode. From the drop-down menus, choose the default mode for your Outlook calendar's ON and OFF hours.
   - When my calendar is busy change my Call Handling Mode. From the drop-down menu, choose the default mode for when you have an Outlook calendar appointment.
   - When my calendar is out of office change my Call Handling Mode. From the drop-down menu, choose the default mode for when your Outlook calendar indicates you are out of office.
3. Use your Outlook calendar to indicate available (free time) and busy hours (busy time).

   The Call Handling Mode icon, on the ShoreTel Communicator Assignment bar, automatically changes to indicate the call handling mode indicated by your calendar. ShoreTel uses this mode to handle all incoming calls until you either manually select a different mode, or another automatic mode transition is performed by the calendar.

4. If you want to set the call handling mode for an open appointment, click the Call Handling Mode button. From the drop-down menu, choose the appropriate call handling mode for the appointment.

5. Click Save & Close.
CHAPTER 7

Special Features

Overview ................................................................................................................... 72
Making Calls ............................................................................................................ 72
  Using the Make Call Dialog Box ........................................................................ 72
  Making and Answering Special Calls .............................................................. 73
Intervening in a Call ............................................................................................ 74
Transferring Calls to Special Recipients .......................................................... 74
Parking and Picking Up a Call ............................................................................. 75
Changing Another User’s Call Handling Mode ............................................... 76
Sharing Call Appearance .................................................................................... 76
Viewing and Adding Information on a Call ...................................................... 77
Using ShoreTel Workgroups ............................................................................... 77
  Logging into and out of a Workgroup ............................................................. 78
  Using Call Wrap-Up ......................................................................................... 79
  Monitoring Your Queue .................................................................................. 79
  Monitoring Agents ......................................................................................... 80
  Monitoring Bridged Calls .............................................................................. 81
Using a Workgroup Voice Mailbox ................................................................... 82
Transferring Calls from the Contacts Window ................................................ 82
Overview

ShoreTel Communicator provides special features for operators, assistants, and contact center personnel. These features are:

- Making a call to an intercom or paging system, and answering the night bell.
- Intervening in a call
- Transferring a call with a consult or whisper, and to an intercom or mailbox
- Parking and picking up a call
- Changing another user’s call handling mode
- Sharing a call appearance
- Viewing and adding information on a call
- Using ShoreTel Workgroups
- Working with many of these special features often involves using the Make Call dialog box.

If you are using Contact Center integrated with ShoreTel Communicator, refer to the Contact Center Using Agent Toolbar guide for information.

Making Calls

Using the Make Call Dialog Box

The Make Call dialog box allows you to make calls to a single contact and to make special calls. The title of this dialog box changes to indicate the specific type of call you want to make.

1. Enter the call recipient’s name or number in the field at the top.
   Matches from the directory are displayed below as the text is entered.

2. Select the call recipient.
   If additional information on the recipient is available, this information is displayed in the Extended Information field.
   The Dial Digits field shows the number that will be dialed.

3. Click the appropriate button for the type of call you want to make.
   Buttons are only available if the recipient has permission to receive that type of call.
Making and Answering Special Calls

ShoreTel Communicator allows you to make and answer the following types of special calls:

- Intercom
- Paging system
- Night bell

Making a Call to an Intercom

You can place a call simultaneously to multiple users through their intercom. Depending on the type of phone being used by the recipients, the call is either answered automatically with a preceding announcement, or treated as a normal call. Intercom calls override the recipient’s active call handling mode and ring the extension.

You must have authorization from your system administrator to make or receive intercom calls.

- From the Contacts window, select the recipients and click Intercom.
- From the Contacts window, right-click on the recipients and from the resulting menu choose Intercom.
- Choose Intercom from the Dial menu. Use the Intercom dialog box to locate and select the recipients and then click Intercom.

The call is placed and call details are displayed in the Active Call area.

Calling Your Overhead Paging System

You can call the extension of your site’s overhead paging system to broadcast the call through the paging system.

Your site needs to have a configured paging extension, and you must have authorization from your system administrator to call the paging system.

- Choose Overhead Page from the Dial menu.

The call is placed and call details are displayed in the Active Call area.

Answering the Night Bell

The Night Bell is an extension that is tied to a site-wide signaling device and can be answered only if you have authorization from your system administrator.

- Choose Pickup Night Bell from the Dial menu.
Intervening in a Call

Using ShoreTel Communicator, you can intervene in an existing call. To intervene in a call you must have system administration authorization; users whose calls can be interrupted must also be authorized.

ShoreTel Communicator supports the following types of interventions:

- **Barge In.** Allows you to listen to and speak with all call participants.
- **Silent Monitor.** Makes it possible for you to listen in on a call without any of the call participants knowing. When a call is being monitored, external callers may hear a monitor tone; system users are not signaled when their calls are monitored.
- **Silent Coach.** Allows you to speak to your colleague and listen in on the conversation, without the other party on the call knowing.
- **Whisper Page.** Allows you to speak to your colleague without the other party knowing, and you are unable to hear the other caller. With Whisper Page you are not listening in on the conversation but just communicating with your colleague.

You can switch between different types of interventions during a call.

**Intervening on a call**

1. From the Contacts window, click the appropriate icon for the type of intervention you want to perform.
   
   You can also use the Call menu to choose the appropriate command for the type of intervention you want to perform.

2. Using the Make New Call dialog box, specify the extension you want to intervene in and then click the button of the action you want.

**Switching intervention types**

1. Select the call in the Active Call area.

2. Click the icon for the appropriate type of intervention to which you want to switch.

   You can also use right-click on the active call, and from the resulting menu choose the appropriate command for the type of intervention which you want to switch.

**Transferring Calls to Special Recipients**

ShoreTel Communicator supports the following types of special transfers:

- **Consult.** Connects you to the recipient of the transfer, then sends the call upon your signal. This allows you to introduce the call to the recipient before the transfer.

- **Mailbox.** Transfers the call to the recipient’s voice mailbox.
Special Features

Parking and Picking Up a Call

- **Intercom.** Transfers the call to the system intercom.

- **Whisper.** Allows you to break into an active call, and communicate with one party without the other party hearing, before transferring the call.

1. Select the call you want to transfer in the Active Call area.

2. Click **Transfer**.

   The call is placed on hold.

3. Using the **Transfer dialog box**, specify the extension to which you want to transfer the call and then click the button of the action you want.

Parking and Picking Up a Call

Parking a call places the call on hold at another extension. This allows you to park a call on one extension and pick it up from a different extension. The parked call appears in the recipient's Active Call area as a call on hold. Picking up a call, if you have authorization from your system administration, makes it possible to answer calls from another user's extension.

Unparking a call is retrieving a call that you previously parked on another extension. Calls can be unparked only by the person that originally parked it.

Bounced calls are unanswered parked calls, which are returned to the extension from where they were parked as an incoming call, after a period specified by your system administrator.

Once parked, the call is removed from the Active Call area.

ShoreTel Communicator supports the following types of park:

- **Park.** Parks the call at the specified extension with no additional action.

- **Park/Intercom.** Parks the call and then calls the recipient's intercom. Use this type of park if you first want to contact the recipient of the parked call.

- **Park/Page.** Parks the call and then pages the recipient. Use this type of park if you first want to contact the recipient of the parked call.

Parking a call

1. In the Active Call area, right-click on the call you want to park and select **Park** from the resulting menu.

   You can also:

   - Click **Park** on the Call toolbar.
   - Choose **Park** from the **Call** menu.

2. **Use the Park dialog box** to locate and select the call recipient, and then click the appropriate button for the type of park you want to make.
Picking up a parked call

1. Choose Pickup/Unpark from the Dial menu.

2. Use the Pickup/Unpark dialog box to locate and select the extension you want to pickup, and then click Pickup.

Unparking a call

1. Choose Pickup/Unpark from the Dial menu.

2. Use the Pickup/Unpark dialog box to locate and select the park recipient, and then click Unpark.

Changing Another User’s Call Handling Mode

You can change another user’s current call handling mode if you have the proper permissions, and if you have been added to that user’s authorization list.

- From the Contacts window, right-click on the user whose call handling mode you want to change and from the resulting menu choose CHM Delegation.

Sharing Call Appearance

Shared call appearance allows multiple locations to share an extension number and manage calls. Incoming calls ring at the multiple locations simultaneously. All devices where call appearance is shared can be used to answer an incoming call or make a call as if it is the main user. In addition calls put on hold on one device can be retrieved from any other device sharing that call appearance. Shared call appearance is typically established to allow an assistant to manage an executive’s calls.

Shared call appearance requires that your system administrator create an executive extension, program a hotline button, and establish a hotline circuit between the executive and assistant(s).

Sharing appearance for inbound calls

1. Answer the inbound call for the executive, that is indicated on your device by a flashing indicator.

2. Determine the caller’s name and purpose.

3. Place the call on hold.

4. Press the hotline button to call the executive.

5. Advise the executive of the call on hold and provide instructions on picking up the call.

Sharing appearance for outbound calls

1. Press the appropriate IP Phone or ShoreTel Communicator button associated with the executive’s extension.

2. Call the recipient and prepare the recipient for the executive’s call.

3. Place the call on hold.
4. Press the hotline button to call the executive.

5. Advise the executive of the call on hold and provide instructions on picking up the call.

**Viewing and Adding Information on a Call**

You can view details on a call using ShoreTel Communicator. This includes origination and destination information, the duration of the call, the list of extensions that handled the call, and notes on the call added by a participant. You can view details on an active call and view details on a previous call.

- Click the More Info icon associated with the call you want details on in the Active Call area.
- Right-click on the call in the Active Call area and select More Info from the resulting menu.
- Choose More Info from the Call menu.

The details are shown in the Call Details window.

If you want to add details to the active call, for example to describe the final disposition of the call, enter the information in the Add to Call Note field. Then press Enter or click +. The information is prefixed with your name and extension.

If you need to make changes to the Call Note before the call ends, select Allow direct editing of the Call Note. The Call Note field becomes active, allowing you to type directly in the note.

1. In the History window, right-click on the call on which you want information.

2. From the resulting menu, choose Properties.

   A stand-alone Call Details window opens, with information on the call. Note that this window contains additional details on the call, specifically Name, Start Time, and Duration.

3. If you want to add details to the active call, for example to describe the final disposition of the call, enter the information in the Add to Call Note field. Then press Enter or click +. The information is prefixed with your name and extension.

4. If you need to make changes to the Call Note before the call ends, select Allow direct editing of the Call Note. The Call Note field becomes active, allowing you to type directly in the note.

**Using ShoreTel Workgroups**

ShoreTel Workgroups is an application for small, informal Automatic Call Distribution (ACD) groups using the ShoreTel system. Workgroups support basic call routing, agent management, reporting, and agent activity functions.

With ShoreTel Workgroups you can:

- Log into and out of a workgroup
- Use call wrap-up
Special Features

Logging into and out of a Workgroup

- Monitor your queue
- Monitor agents
- Monitor bridged calls
- Use a workgroup voice mailbox
- Transferring calls from the Contacts window

You can customize your Workgroups experience by:

- Showing an alert, and defining how long the alert is displayed, when a call is in the queue of one of your workgroups.
- Identify the workgroups that you want to display in the Queue Monitor and Agent Monitor.
- Changing the default number of calls, and the amount of call time, required to trigger a threshold exceeded warning in the Queue Monitor.
- You must be a supervisor or other user with the proper permissions to make these changes.
- Selecting an audio alert to indicate an exceeded threshold.

For information, see the section Specifying Workgroups Options on page 92.

You need to have the appropriate version of ShoreTel Communicator to use ShoreTel Workgroups and specific Workgroups features. If you are using ShoreTel Contact Center integrated with ShoreTel Communicator, refer to the Contact Center Using Agent Toolbar guide for information.

Logging into and out of a Workgroup

You receive calls to your workgroup extension when you are available and are logged into the workgroup call. If you belong to multiple workgroups, you can receive calls from all the workgroups to which you are a member when your status is Available. Your workgroup status applies to all your workgroups. ShoreTel Communicator displays workgroup status in the Status bar.

Your call control status appears in the Agent Monitor, which advises workgroup supervisors of your availability to accept workgroup calls. The workgroup supervisor can also log members in or out of the workgroup.

Depending on the workgroup's configuration, you may also be logged out automatically if you do not answer a workgroup call while logged in.

1. Click on the workgroup icon on the Assignment bar.
2. From the menu, choose either Logged In or Logged Out.

The icon on the Assignment bar changes to indicate your state.

You can also choose Workgroup > Logged In or Workgroup > Logged Out from the ShoreTel button.
Using Call Wrap-Up

Call wrap-up gives you time between calls to complete notes or finish updates to customer records. You are not available to accept calls from the queue when you are in Wrap-Up mode. After the Wrap-Up interval ends, you are automatically logged into the workgroup. The wrap-up interval is defined for each workgroup and configured by your system administrator.

You can change your Wrap-Up status before the interval ends by logging in or out of the workgroup.

1. Click on the workgroup icon on the Assignment bar.
2. From the menu, choose Wrap-Up.

   The icon on the Assignment bar changes to indicate your state.

   You are entered into the Wrap-Up mode.
3. To exit the Wrap-Up mode, log into or out of your workgroups.

Monitoring Your Queue

ShoreTel Workgroups provides the Queue Monitor window to show the calls that are ringing into your workgroups. The Queue Monitor displays in bold red any queue size and queue time thresholds that have been exceeded.

The Queue Monitor’s Workgroup area lists the workgroups to which you belong and provides information on each workgroup. The Workgroup area is made up of the following columns:

- **Workgroup.** The workgroup name and extension.
- **CHM.** The active Call Handling Mode for the group.
- **Queued Calls.** The number of calls in the workgroup queue.
- **Longest Queued Time.** The longest queue time of all calls in the queue.
- **Longest Call Time.** The longest call time of all calls in the queue. This time differs from the longest queue time when calls are returned to the queue after an agent answers it.

The Call area of the Queue Monitor lists the calls that are in the queues of the workgroups to which you belong. The columns of the Call area are:

- **Workgroup.** The call’s intended recipient workgroup.
- **Caller Name / Number.** The Call ID information for the call.
- **Queued Time.** The period that the call has waited in the queue.
- **Call Time.** The period the call has been active including, for calls re-entering the queue after being by an agent, all periods the call was active and on hold.
- **DNIS.** The DNIS identification number sent by the originating call.
- **More Info.** Miscellaneous call information including the routing slip and the call note.

1. Open the Queue Monitor by clicking on the workgroup icon on the **Assignment** bar.
2. From the menu, choose **Queue Monitor.**
   The Queue Monitor window opens.
3. To turn on or off the audio alert the indicates an exceeded threshold, click **Alert Sound.**
4. Click **Options** to **customize your Queue Monitor.**
5. To display the calls of a workgroup in the Call area, click the box associated with a workgroup.
6. To change the call handling mode for a workgroup, click the CHM field for that workgroup and from the resulting menu choose the mode you want.

   The call handling modes are On-Hours, Off-Hours, Holiday, and Custom. The workgroup call handling mode changes the way calls are handled based on the current setting.

### Monitoring Agents

For supervisors and other users with the appropriate permissions, the Agent Monitor window displays the status of agents for each of your workgroups. Agent Monitor also plays an audio alert while a new call rings an agent.

From the Agent Monitor window you can also make a call, pickup a call, engage in IM, intervene in a call, log the agent into or out of a workgroup, put the agent in wrap-up mode, and display status and call handling information (**More Info** icon). To do so, select the agent and click the appropriate icon on the toolbar.

1. Open the Agent Monitor by clicking on the workgroup icon on the **Assignment** bar.
2. From the menu, choose **Agent Monitor.**
   The Agent Monitor window opens.
3. To change how you view agents, right-click in the Agent Monitor window and from the resulting menu choose one of the following options:
   - **Details**: Shows information on the agent’s log status, phone number, extension status, current call handling mode, call state of the call currently being handled by the agent, number of calls in their call stack, and the duration of the call currently being handled by the agent.
   - **List**: Displays the agent’s name and log status. The List view is the default.
   - **Small Icons**: Organizes the agents into a single list (i.e. not grouped), and displays their phone status using small icons.
   - **Large Icons**: Organizes the agents into a single list (i.e. not grouped), and displays their phone status using large icons.

4. If you want to sort by the number of calls in an agent’s call stack, click the **# Calls** heading.

5. To search for an agent, from the search field at the top of the window, enter information on the agent.
   
   Matches are displayed in the window as the text is entered.

---

### Monitoring Bridged Calls

For operators and other users with the appropriate permissions, the Bridged Call Appearance Monitor window displays the bridged calls that your extension has been configured to answer.

A bridged call is an extension that is shared among multiple users.

1. Open the Bridge Call Appearances Monitor by, from the ShoreTel button, choosing **Workgroup > Bridged Call Appearance Monitor**.

   The Bridged Call Appearance Monitor window opens.

2. To change how you view bridged calls, right-click in the Bridged Call Appearance Monitor window and from the resulting menu choose one of the following options:
   - **Details**: Shows information on the call’s extension, stack position, call state, and call duration.
   - **List**: Displays the call’s extension and stack position. The List view is the default.
   - **Small Icons**: Organizes the calls into a single list (i.e. not grouped), and displays call status using small icons.
   - **Large Icons**: Organizes the calls into a single list (i.e. not grouped), and displays call status using large icons.

3. To search for a bridged call, from the search field at the top of the window, enter information on the call.

   Matches are displayed in the window as the text is entered.

4. To access a ringing or parked call, select the call and click **Retrieve**.
5. To display call information, including the phone number and call duration, select the call and click **More Info**.

**Monitoring Bridged Calls for the Softphone/Analog Phone**

For an IPDT phone (e.g., IP 230) that is not a WonderPhone (IP212k/230/230g/etc.) and that uses Button Box tables:

- The Button Box table is used if the IP212k/230/230g/etc. table is not configured.
- No BCA Monitor is displayed if the IP212k/230/230g/etc. and the Button Box tables are not configured.

For a WonderPhone that uses the IP655 table:

- No BCA Monitor is displayed if the IP655 table is not configured.

For a SoftPhone or an Analog phone (not an IPDT phone) that uses the IP655 table:

The IP212k/230/230g/etc. and Button Box tables are used if the IP655 table is not configured.

---

**Note**

In older releases, the IP212k/230/230g/etc. and Button Box tables took precedence over the IP655 table.

**Using a Workgroup Voice Mailbox**

Each workgroup has its own workgroup voice mailbox, and each member of the workgroup can access this mailbox. A list of workgroup voice mails, in the order they are received, is displayed separately in your **Voice Mail window**.

Using the Voice Mail window you can select your playback and recording device; listen to, replay to, and create a voice mail, and manage your voice mail. See **Chapter 4** for information.

**Transferring Calls from the Contacts Window**

As a ShoreTel Workgroups user, from the Contacts window you can easily transfer calls.

- Drag and drop an active call to the contact to which you want to transfer the call.
CHAPTER 8

Customizations

Overview ................................................................................................................... 84
Customizations.......................................................................................................... 84
  Configuring Call Handling Modes ........................................................................ 86
  Personalizing Call Handling .............................................................................. 87
  Specifying Voice Mail Options ......................................................................... 90
  Enabling Microsoft Outlook Integration Features .............................................. 92
  Specifying Workgroups Options .................................................................. 92
  Specifying Telephony Options .................................................................... 93
  Specifying Instant Messaging Options .......................................................... 94
  Specifying SoftPhone Options ................................................................... 96
  Specifying Video Options ........................................................................... 96
  Choosing Sounds ......................................................................................... 97
  Identifying the Language to be Used .......................................................... 98
  Personalizing ShoreTel Communicator ...................................................... 98
Overview

ShoreTel Communicator can be personalized and customized for the way you work. This includes:

- Configuring phones.
- Configuring call handling modes.
- Personalizing call handling.
- Specifying voice mail options.
- Enabling Microsoft Outlook integration features.
- Specifying Workgroups options.
- Specifying telephony options.
- Specifying instant messaging options.
- Specifying SoftPhone options.
- Specifying video options.
- Choosing sounds to indicate incoming calls and voice mail messages.
- Identifying the language used by ShoreTel Communicator.
- Personalizing how ShoreTel Communicator starts up and looks.

You customize ShoreTel Communicator using the Options and Preferences window, which can be accessed from the **ShoreTel button > Options** command.

Customizations

Configuring Phones

Before you can use ShoreTel features such as Extension Assignment, Ring Additional Phones, or Find Me, you need to first configure the phone you want to use with those features. Configuring a phone involves identifying the phone number to the system, and then specifying how incoming calls to that phone are routed.

**Identifying a Phone Number**

If you want to route your call a phone number other than your primary phone or SoftPhone, you need to identify that phone in the ShoreTel system.

1. From the Options and Preferences window, click **My Phones**.
The My Phones page is displayed.

2. If the phone you are configuring is your mobile or home phone, enter the phone number in the field associated with that type of phone. Otherwise, enter a name for that phone in a Label field and enter the phone number in the associated field.

   You can find a specific phone number by entering information in the field; matches from the directory are displayed as the text is entered. Select the number you want.

3. If you want to change the number of times the phone rings before being sent to voice mail, and the number you press to answer a call, click the button associated with that specific phone. Use the Advance Phone Settings dialog box to specify the settings you want and then click OK.

   By default, configured phones are set to ring 3 times before being sent to voice mail, and to be answered by pressing 1.

   **Note**
   For extensions and mobile phones the **Press 1 to answer calls** option is not available.

4. Click OK.

### Specifying Incoming Call Routing

Once a phone has been identified, you can specify how incoming calls to that phone are routed.

1. From the Options and Preferences window, click **Incoming Call Routing**.

   The Incoming Call Routing page is displayed.

2. From the **Incoming calls ring** drop-down menu, choose the configured phone for which you want to identify incoming call routing. This is also the phone to which your extension is, or will be, assigned.

3. In the **Ring Additional Phones** area, select the call handling mode(s) for which you want additional phones to ring simultaneously. Then choose the configured phone(s) that you want to ring.

4. Use the options in the **Find Me** area to specify if you want callers who are routed to your voice mailbox to be able to contact you. These options are

   - **When callers reach my voicemail and my Call Handling Mode is**. Select the call handling mode(s) for which callers can reach you.
   - **Find me at the following phones**. Specify the first and second phones, in order, to which the call is routed. These can be internal extensions or external phones.
   - You can find a specific phone number by entering information in the field; matches from the directory are displayed as the text is entered. Select the number you want.
   - **Send incoming Caller ID**. Select if you want the incoming caller’s ID sent to the Find Me destination. The caller ID is displayed before you answer the call.
Enable record caller's name for Find Me. Select to prompt the caller to record their name for calls routed to the Find Me destination. The caller’s name is then played before you answer the call. You can then select Record name even if caller ID is present to require all callers to record their name, regardless of the availability of their Caller ID. This excludes internal users whose name was previously recorded.

Automatically find me before playing my greeting, instead of caller pressing “1” during greeting. Select to route calls to the Find Me destination without requiring the caller to press 1.

5. Click OK.

Configuring Call Handling Modes

A call handling mode determines the manner that your inbound calls are handled in a variety of situations. ShoreTel provides five call handling modes: Standard, In a Meeting, Out of Office, Extended Absence, and Custom.

You configure whether you want warnings about how the Standard call handling mode is being used when starting up ShoreTel Communicator, which users can change your call handling mode, and the definition of each call handling mode. This definition can include a recorded greeting and specifies how to handle call forwarding in various situations.

1. From the Options and Preferences window, click Call Handling Mode.

The Call Handling Mode page is displayed.

2. If you want to change your current call handling mode, choose the mode from the Current call handling mode drop-down window.

3. Select the appropriate options if you want warnings about how the Standard call handling mode is being used when starting up ShoreTel Communicator. These options are

 Warn when not using Standard Call Handling Mode. A warning is displayed if the active call handling mode is not Standard.

 Warn when Standard Call Handling Mode is set to Forward Always. A warning is displayed if the active call handling mode is Standard, and the option Forward Calls is set to Always.

4. If you want to allow another system user to change your current call handling mode, use the Allow these users to change current call handling mode field to find and choose the user. Then click Add. The user is added to a list in the field below.

You find a user by entering information on the user in the field; matches from the directory are displayed as the text is entered.

To remove a user from the list of those that can change your current call handling mode, select the user in the list and click Remove. Then click Apply.

5. To change the definition of a call handling mode, select the mode in the Options and Preferences window navigation list. Using the page for that call handling mode, select the appropriate options and then click OK. These options are
- **Record greeting.** Click to record a greeting that callers hear when they reach your voice mailbox. Use the Record bar to record your message by clicking the **Record** button, and speaking into your telephone handset or headset. When done, click **Stop**. Use the **Play** button and cursor to review the recording. When satisfied with the recording, click **OK**.

  **Note**

  You can have a different recorded greeting for each call handling mode.

- **Forward calls.** Select whether you want your calls to be forwarded **Always**, **When no answer or busy**, or **Never**. If you select either of the first two options, you can change the default destination(s) (described in the field below) of your forwarded calls by clicking **Change Destination**. Use the resulting dialog box to find and choose the new destination(s). Then click **OK**.

  For the option **When no answer or busy**, two destinations are specified: the destination when a call is not answered after the specified number of rings, and the destination when a call is not answered because the line was busy.

  You find a destination by entering information on the destination in the field; matches from the directory are displayed as the text is entered. If you are specifying the destination when a call is not answered, you can select the number of times the phone rings before being forwarded from the **Forward after** field.

- **When caller presses “0”, transfer to.** To designate a recipient of your calls other than the operator when the caller presses 0 (zero) while listening to your voice mail greeting, find and choose the recipient from the associated field.

  You find a recipient by entering information on the recipient in the field; matches from the directory are displayed as the text is entered.

- **Scheduled mode change.** If the call handling mode allows for schedule mode changes, choose the appropriate schedule from the associated field’s drop-down menu.

  Schedules are created and maintained by your system administrator. Contact your system administrator for an explanation of a schedule or if you need a custom schedule.

- **Voice mail escalation profile.** If you want to assign a voice mail escalation profile to the call handling mode, from the drop-down list, select the profile you want to use.

  A voice mail escalation profile defines a series of contact attempts when you do not respond to an inbound voice message requiring an immediate response. These profiles are specified using the Options and Preference > Escalation page.

- **Call handling note.** Enter details about the definition of this call handling mode.

### Personalizing Call Handling

Personalizing call handling allows you to create personal rules that further define call routing.

You can also modify and delete personal rules.
Creating a personal rule

1. From the Options and Preferences window, click **Personalized Call Handling**.

   The Personalized Call Handling page is displayed.

   **Click New Rule.**

   From the Personalized Call Handling Setup dialog box, select the condition(s) for the rule, then click **Next**. These conditions are

   - **Phone number match**: Matches the caller ID with a parameter(s), which is specified by clicking on **Phone Number Match** in the Condition Description field and using the Phone Number Match dialog box.

     To specify a parameter to match the caller ID, from the **Match Type** drop-down list choose the parameter, enter the number in the associated field, and then click **OK**. Click **Add** or **Delete** to add or delete parameters to the condition.

   The parameters are

   - **Specific Number**: The number that must match the caller ID; numbers can be an internal extension or a phone number external to the system.

   - **Every internal number**: Matches all calls originating from a device within the ShoreTel network.

   - **Any internal extension starting with**: The digits that must match the initial digits of numbers originating from internal callers.

   - **Every external number**: Matches all calls originating from a device not located within the ShoreTel network.

   - **Any external extension starting with**: The digits that must match the initial digits of numbers originating from outside the system.

   - **Off system extension**: The off system extension that must match the caller ID.

   - **Private**: Matches all calls that are identified by caller ID as private.

   - **Out of Area / Unknown**: Matches all calls that caller ID identifies as out of area or unknown.

   - **I am on the phone**: This condition is satisfied when your phone is busy.

   - **Call Handling Mode**: Matches your active call handling mode with a mode, which is specified by clicking on **Call Handling Mode** in the Condition Description field and using the resulting dialog box.

---

**Note**

You must have the appropriate license to personalize call handling.
Customizations Personalizing Call Handling

- **Time of day**. This condition is satisfied when a call is received during the a time range, which is specified by clicking on **Time of Day** in the Condition Description field and using the resulting dialog box. The actual time is based on your the time zone.

- **Day of week**. This condition is satisfied when a call is received on a day, which is specified by clicking on **Day of Week** in the Condition Description field and using the resulting dialog box. The day is based on your the time zone.

- **DNIS Match**. Matches the DNIS of an inbound call with a parameter(s), which is specified by clicking on **DNS Match** in the Condition Description field and using the **Set dialed number string** dialog box to enter the string.

2. Select the action for the rule, which is the resolution for a call that matches the specified condition, and then click **Next**. These actions are:

- **Forward Call to Specific Number**. Routes the call to a number, which is specified by clicking on **Forward Call to Specific Number** in the Action Description field and using the **Forward Call** dialog box to choose either **Specific Number** or **Off System Extension** and then enter the number.

- **Forward Call to Voice Mail**. Routes the call to your voice mail.

- **Forward Call to Auto Find Me**. Routes the call to your voice mail, and then to your Find Me number.

- **Forward Call to Announced Find Me**. Routes the call to your voice mail, and then to your Find Me number; the caller’s name is played before you answer the call.

- **Play Ringtone**. The phone plays a ringtone, which is specified by clicking on **Play Ring Tone** in the Action Description field and using the **Select ring tone** dialog box.

This action is only available for ShoreTel phones that support multiple ringtones.

3. Enter a name for this rule, and click **Finish**.

The rule is displayed in the Personalized Call Handling dialog box. The rule is enabled by default.

4. Use the Personalized Call Handling dialog box to change whether a rule is enabled and to reorder the list of rules. ShoreTel enacts the rules in the order displayed here.

5. Click **OK**.

**Modifying a personal rule**

1. From the From the Options and Preferences window, click **Personalized Call Handling**.

2. Using the Personalized Call Handling page, select the rule you want to modify and click **Modify Rule**.

3. Follow steps 3-7 above.

**Deleting a personal rule**

1. From the Options and Preferences window, click **Personalized Call Handling**.
2. Using the Personalized Call Handling page, select the rule you want to delete and click **Delete Rule**.
   
The rule is deleted from the list.

3. Click **OK**.

### Specifying Voice Mail Options

Using voice mail options, you can specify how your voice mail is recorded and played, delivered, and escalated. In addition, you can record a new message and change your voice mail password.

You can also specify the sound that is played when a new voice mail is received from **Options and Preferences window > Sounds** page, and the language used for voice mail audio prompts from the **Options and Preferences window > Language** page.

### Specifying voice mail options

1. From the Options and Preferences window, click **Voice Mail**.

2. Using the Voice Mail page, select the appropriate options and then click **Apply**.

   These options are:

   - **Play messages using PC speakers**. Plays voice mail through your computer speakers instead of your phone.

   - **Record messages using PC microphone**. Records voice mail through a microphone that accesses your computer’s sound card.

   - **Play envelope information when listening to messages**. Plays sender and receipt time information prior to listening to a voice mail.

   - **Change Password**. Click to change the password that protects access to your voice mail.

   - **Record Name**. Click to change the recording of your name played to callers when they are routed to your voice mail.

   - **Notification delivery options**. Specifies the media the system uses to inform you of the receipt of a voice mail. The delivery options are:

     - **Disabled**. Notification is disabled.

     - **Email Wave file**. A copy of the voice mail, attached as a WAVE file, is sent to the specified email address.

     - **Email notification**. An email message indicating the receipt of a voice message is sent to the specified email address.

     - **Mark delivered voice mail as Heard**. The notification indicates that the voice mail has been heard.

     - **Deliver to email address**. The email address to which notifications are to be sent.
3. To define how notifications for new or unheard voice mail is escalated, click **Escalation** in the Options and Preferences window navigation list.

4. Using the Escalation page, select the appropriate notification option. These options are

   - **Notify for first unheard message.** Begins escalating voice mail one at a time. The system stops escalating a voice mail when it is marked Heard.

   - **Notify for each new message.** Escalates each voice mail, allowing for concurrent escalations.

5. The escalation notification profile that is used is determined by the active call handling mode. If you want to define or modify an escalation notification profile, select the profile in the list and click **Edit.** Use the Escalation Notification Profile dialog box options to specify the profile's definition. Then click **OK.**

   A profile definition is made up of the profile name, the number of times the escalation is repeated, and the steps involved in the escalation. Each profile can have up to 10 individual steps.

   The options are

   - **Profile Name.** The name of the profile.

   - **Repeat Count.** The number of times the escalation is repeated. Escalation is also discontinued when the voice mail is marked as Heard.

   - For a selected step

   - **Timeout.** The amount of time, in minutes, that the specified phone will ring with an escalated voice mail before the system sends a notification message.

   - **Notify me of urgent messages only.** Only voice mails marked Urgent are escalated. ShoreTel allows callers to mark a voice mail as urgent after recording the message.

   - **Email Notification Options.** The media and email address the system uses to send an escalated voice mail. The delivery options are

     - **Disabled.** Notification is disabled.

     - **Email Wave file.** A copy of the voice mail, attached as a WAVE file, is sent to the specified email address.

     - **Email notification.** An email message indicating the receipt of a voice message is sent to the specified email address.

   - **Telephone Notification Options.** The phone or pager number the system uses to send an escalated voice mail.

6. You can delete an escalation profile by selecting it in the list on the Escalation page and clicking **Delete.**

7. Click **OK.**
Enabling Microsoft Outlook Integration Features

By enabling Microsoft Outlook integration, you can manage your voice mail, contacts, and appointments from within Outlook.

1. From the Options and Preferences window, click Outlook.

   The Outlook page is displayed.

2. Select the appropriate Contact Upload options. These options are
   - Upload Personal Contacts. Uploads your personal Outlook contacts to the ShoreTel server, so that these contacts are available to Communicator
   - Upload Options. Select the Outlook folder(s) from which the personal contacts are uploaded.
   - Open Outlook contacts when calls arrive. The Outlook Contacts form opens when you receive a call from an Outlook contact.

3. To turn on voice mail integrated with Outlook, close Outlook and from the Voice Mail area click Install.

4. To turn on calendar integration, close Outlook and from the Calendar area click Install.

   Calendar integration enables your call handling mode to be updated by Outlook, and the ability to work with ShoreTel Web conferences from within Outlook.

5. If you want your active call handling mode to be automatically changed based on appointments in the Outlook calendar, select Use Outlook appointments to change Call Handling Mode.

   Calendar integration (i.e. step 4) must be installed to use this option.

   You also need to turn on call handling mode in Outlook, as explained in the section Section Automatically Setting Call Handling Using Outlook on page 69.

6. Click OK.

Specifying Workgroups Options

If you are using ShoreTel Communicator with Workgroups in a call center, you can specify the workgroups to which you belong, determine the workgroups that the Queue Monitor and Agent Monitor display, and configure thresholds.

You can also specify the sound that your computer plays when a threshold has been exceeded from Options and Preferences window > Sounds page.

1. From the Options and Preferences window, click Workgroups.

   The Workgroups page is displayed.

2. Select Show alert when call is in queue to receive a popup alert when a call is in the queue of one of your workgroups. Then specify how long the alert is displayed, in seconds, using the Alert display time field.

3. Select the workgroups, in the list, that you want to display in the Queue Monitor and Agent Monitor.
4. All the workgroups to which you belong are listed.

5. If you have the proper permissions, you can change the default number of calls required to trigger a threshold exceeded warning in the Queue Monitor. To do so, click the Calls in Q you want to change for the associated workgroup, and specify a new number.

6. If you have the proper permissions, you can change the default call time required to trigger a threshold exceeded warning in the Queue Monitor. To do so, click the Queued Time you want to change for the associated workgroup, and specify a new time.

7. Click OK.

Specifying Telephony Options

The telephony options can be used to specify the manner in which ShoreTel Communicator interfaces with your telephone.

You can also specify the sound that is played for incoming internal and incoming external calls from Options and Preferences window > Sounds page, and the language used to display IP phone messages from the Options and Preferences window > Language page.

1. From the Options and Preferences window, click Telephony.

   The Telephony page is displayed.

2. To change servers (HQ servers and DVS servers), enter the name of the new server in the Server name field.

   Contact your system administrator for information on the correct server name to use.

3. If you want to change the user name you use to access ShoreTel Communicator, enter a new user name in the User name field, click OK, and then exit and restart Communicator.

   This field is read-only if you are authenticated as a user through Active Directory credentials.

4. You can change the password you use to access ShoreTel Communicator by clicking Change Password and using the Change Password dialog box.

   This field is read-only if you are authenticated as a user through Active Directory credentials.

5. From the Maximum number of active calls to show drop-down menu, choose the number of active calls you want ShoreTel Communicator to handle at a time.

   The maximum number you can choose is configured by your system administrator.

6. Select Show empty call cells in Normal view to display selected active calls in separate rows in the Active Call area of Communicator.

7. If you want to see an alert when receiving a voice call, select Show incoming call alert.

8. To disable the call waiting tone, select Suppress call waiting tone for subsequent calls.
The call waiting tone is a signal inserted into the audio path during a voice call to alert you of an inbound call. Calls that you receive when the call waiting tone is suppressed are handled as specified by your active call handling mode.

9. Select **Suppress dial-tone when off-hook** to use ShoreTel Communicator with a headset or speaker phone instead of a receiver (i.e. in handsfree mode).

The phone is off hook and the dial tone is suppressed. At the conclusion of a call you can initiate a new call without hanging up the phone.

10. If you need to dial a prefix to make an external call, use the **Prefix to dial external number** drop-down menu to choose the prefix.

11. Click **OK**.

### Specifying Instant Messaging Options

ShoreTel Communicator allows you to specify alert and IM window options, your user name on the IM server, IM and presence display options, and privacy permissions.

You can also specify the sound that your computer plays when it receives an instant message from **Options and Preferences window > Sounds** page.

1. From the Options and Preferences window, click **Instant Messaging**.

2. Using the Instant Messaging page, select the appropriate options and then click **Apply**. These options are

   - **Sign-in name** and **Password**. The address and password used for instant messaging.
     The address and password are configured by your system administrator.
   - **Show incoming message alert**. Displays an alert on an incoming IM.
   - **Show text of message**. The IM alert displays the text of the incoming message.
   - **Number of seconds to display alert**. The amount of time, in seconds, that the IM alert is displayed.
   - **Show timestamps**. The IM window shows the time and date that messages were sent and received.
   - **Initiate instant messaging when double clicking on a contact in the Contact pane**. Double-clicking on a contact in the Contact window initiates an instant message to that contact.
   - **Show all chats in single window**. Shows all IM sessions in a one window. Each session is accessed by clicking on a tab.
   - **Warn me before closing chat window with multiple conversations**. Displays a prompt each time you attempt to close a chat window with multiple sessions.
   - **Save chat transcript to**. Automatically saves the transcript of all your IM sessions to the specified location.
- **My domain user name and Instant Messaging sign-in are not the same.** If your Active Directory user name is different from your IM sign-in name, enter the user name recognized by the presence server.

3. To specify presence options, click **Presence** in the Options and Preferences window navigation list.

4. Using the Presence page, select the appropriate option and then click **Apply**. These options are
   - **one combined telephony and instant messaging presence.** Displays a single presence icon that indicates the user’s combined presence state.
   - **separate telephony and instant messaging presences.** Displays two presence icons to indicate the user’s telephony and IM presence.
   - **Set Presence to “Idle” after specified minutes of activity.** Your IM presence state is changed to Idle after the specified inactivity period, in minutes.

5. To control who can view your IM presence status and send you IM messages, click **Privacy** in the Options and Preferences window navigation list.

6. Using the Privacy page, select the appropriate option and then click **Apply**. These options are
   - **Auto accept invitation.** All requests for an IM session are accepted. When you receive a request, a notification alert indicates a requestor was granted access to your IM presence status.
   - **Prompt to accept invitation.** You receive an alert that a request has been made for your IM presence status. You can then decide whether to accept or reject the request.
   - **Permissions.** Displays only contacts with the specified type of IM presence permission (chosen from the drop-down menu) in the list. The IM presence permission can be
     - **Show All.** Displays all contacts and their IM presence permission.
     - **Show only Allowed.** Displays all contacts with the IM presence permission of Available (IM messages and presence status is available to this contact).
     - **Show only Blocked.** Displays all contacts with the IM presence permission of Blocked (IM messages and presence status is not available to this contact).
     - **Show only Pending.** Displays those contacts who have requested to exchange IM messages and view your IM presence status, and to which you have not responded to their request.

---

**Note**

This option is only available if your system administrator has configured your Class of Server to User Defined.

- **List of contacts and their IM presence permission.** The contacts, and their IM presence permission. You create this list by clicking **Add** and using the Add Permission dialog box to select a contact and their permission. Note that this option is only available if your system administrator has configured your Class of Server to User Defined.
You select a contact by entering information on the **Name** in the field; matches from the directory are displayed as the text is entered. The **Permission Type** can be either

- **Allowed.** IM messages and presence status is available to this contact.
- **Blocked.** IM messages and presence status is **not** available to this contact.

You can change the IM presence permission of a contact by selecting the contact in the list and clicking either **Allowed** or **Blocked.** To remove a contact from the list, select the contact and click **Delete.** If you want to change the sort order of contacts, click on the **Name** column heading; the direction of the arrow indicates an ascending or descending sort order.

7. Click **OK.**

### Specifying SoftPhone Options

You can specify your SoftPhone device settings.

1. From the Options and Preferences window, click **SoftPhone.**
   
   The SoftPhone page is displayed.

2. From the **Play** and **Record** drop-down menus, choose the device to be used by SoftPhone to play and record audio transmissions, respectively. If you want to restrict the list of available devices, select **Use only configured devices.**
   
   Available devices are specified in the Microsoft Control Panel > Sounds (or Sounds and Audio Properties) panel.

3. From the **Audio device** area, select the device through which you want to access SoftPhone.

4. Use the **Network adapter** drop-down menu to choose the network interface card through which SoftPhone makes calls.

5. In the **Endpoint name** field, enter the string through which ShoreTel controls SoftPhone as an MGCP device.
   
   This field is automatically populated once your extension is assigned to Softphone.

6. Click **OK.**

### Specifying Video Options

If you have the capability to add video to your voice calls, you can specify how video requests are handled and video camera you want to use.

1. From the Options and Preferences window, click **Video.**
   
   The Video page is displayed.

2. Select **Automatically request video when calling** to automatically request a video call when initiating voice calls with users authorized for video.
3. From the **Accept video requests from others** area, select your automatic response to video call requests. These options are

- **Always.** Enable video for all requests.
- **Never.** Reject video for all requests. You can still choose to add video once a call has begun.
- **Ask me.** Receive an alert that a request has been made to add video to a call. You can then decide whether to accept or reject the request.

4. From the **Video camera** drop-down menu, choose the video device that ShoreTel Communicator uses for the video call.

5. To configure brightness, contrast, and saturation settings for the video camera, click **Configure Camera** and use the resulting dialog box.

---

**Note**

While many cameras compensate for poor lighting conditions, this compensation usually impacts the frame rate of the device. Using optimal lighting conditions is essential to ensure the proper frame necessary for good image quality.

---

6. Click **OK**.

### Choosing Sounds

With ShoreTel Communicator, you can choose the sounds you want to indicate incoming communication events.

1. From the Options and Preferences window, click **Sounds**.

   The Sounds page is displayed.

2. From the **Select** list, select the communication event for which you want to specify a sound.

3. Use the **Sound file** drop-down menu to choose the WAV audio file that ShoreTel Communicator plays for the selected event.

   If the WAV file you want is not listed in the menu, click **Browse** and use the resulting dialog box to locate and select the file.

4. To hear the sound of the audio file, click **Play Sound**.

5. Click **OK**.
Identifying the Language to be Used

You can identifying the language used in the ShoreTel Communicator user interface, by your phone, and for voice mail.

1. From the Options and Preferences window, click **Language**.
   
   The Language page is displayed.

2. From the **Language used in ShoreTel Communicator** drop-down menu, choose the language in which you want ShoreTel Communicator’s user interface displayed. Click **Apply** and then use the resulting prompt to exit and restart Communicator.

3. Use the **Language used by voice mail and IP phones** drop-down menu to choose the language for your IP phone display messages and voice mail audio prompts.

4. Click **OK**.

Personalizing ShoreTel Communicator

Options are provided to personalize how ShoreTel Communicator starts up and looks.

1. From the Options and Preferences window, click **Customization**.

   The Customization page is displayed.

2. Select the appropriate options in the **General** area. These options are

   - **Start ShoreTel Communicator when you login to Windows**. ShoreTel Communicator automatically starts whenever you log in to Windows.
   - **Enable drag-and-drop Window arrangement**. Enables ShoreTel Communicator content windows to be displayed in a separate standalone window.
   - **Color scheme**. The background color, chosen from the drop-down menu, of ShoreTel Communicator windows and panels.
   - **Hide ShoreTel Communicator when idle for more than**. The amount of time ShoreTel Communicator is idle before being hidden. The default is 30 seconds. ShoreTel Communicator is not hidden if one or more calls are active.
   - **Always move keyboard focus to the Quick Dialer when activating ShoreTel Communicator**. The keyboard focus is always moved to the Quick Dialer field when ShoreTel Communicator becomes active.

3. Use the options in the **Quick Dialer** area to reflect how you want to use the QuickDialer. These options are

   - **Show fax numbers**. Includes fax numbers in the QuickDialer list and Directory window right-click menu.
   - **Search by company name**. Allows searches on company name.
- **Show extension calling actions.** Displays available methods of contacting filtered extensions.
- **Show Go arrow.** Displays a Go arrow on the right of the QuickDialer field. Clicking the Go arrow initiates a call to the contact in the field.
- **Calls to show in redial.** Displays the specified type (from the drop-down menu) of recently made and received calls from the Redial icon.

4. Click **OK**.